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Editorial
Welcome to Issue 46 (just four 
stops away from the big 50!). Thanks 
to everyone who has stuck with us 
over the past few years, and a huge 
welcome to those who are just joining 
us – we hope you enjoy this and 
many issues to come. Thanks for your 
support; we can’t do it without you!

OK, so we’ve got two really exciting 
interviews this month: we interview 
master of the caricature, Jason Seiler, 

and it’s been a long time coming but we are exceptionally pleased to 
have finally hooked ourselves an interview with none other than Jason 
Manley, for Massive Black. Woo-hoo! So check out the freakishly 
stunning portfolio of Jason Seiler on p.6 and then join us on a journey 
with Jason Manley as we check out some of MB’s latest concept art 
done for the entertainment and animation industries (p.30). Big thanks 
to both Jasons for these really fantastic interviews; they’ve helped make 
this one hell of a special issue, and we hope you’ll get plenty out of their 
words of wisdom, and magnificent art to boot!

Our cover image is by 2DArtist favorite, Carlos Cabrera, who is with 
us this month to show us how we can create a sci-fi masterpiece from 
just a couple of boxes and a simple robot design created in the easy-
to-use freeware, Google SketchUp, before taking it into Photoshop for 
some color, texture, and detail work (p.52). Inspired by old school sci-fi 
movies from the 80s, Carlos knocks up this speed painting in next to no 
time, giving us all the encouragement we need to dabble in the art of 
3D paintovers to help speed up the painting process – and let’s face it, 
in this industry time really is of the essence! It’s not about cheating, it’s 
about improving your workflow and getting great results, so set yourself 
a slot today to try it out and see what it can do for you!

We introduce Mark McDonnell to 2DArtist this month in our dynamic 
character tutorial series who talks to us on the topic of posing 
characters, and the importance of dynamic and exaggerated poses in 
character art. Mark has worked for studios including Walt Disney and 
Pixar, so if you want to find out how to enhance your character designs 
then now is your chance to check out some all-important advice from this 
industry professional (p.78).

Our custom brushes take the direction of special effects for hair and 
skin this time around, with Kirsi Salonen teaching us how to use the 
Pen Tool in Photoshop for interesting effects over on p.66. Lots of free 
custom brushes for all our readers and some great tips and tricks on 
how to create your own – you’ll have a massive library of custom-made 
brushes before you know it! 

For those of you who are still fairly new to Photoshop and learning the 
way of it all, join Nykolai Aleksander in the fourth chapter of the six-part 
Beginner’s Guide to Painting series. This month she shows us how 
to incorporate a photo into our painting, whilst taking a more in-depth 
approach to the whole painting process and discussing various blending 
methods. She has also very kindly supplied some great movie footage to 
accompany this tutorial, so get interactive on p.88 and enjoy the movies 
with a cup of your favorite hot stuff!
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Our making of has kindly been written for this October issue by Oleg 
Matsokin on the creation of his image, Imp Vs. Angel-Warrior, an 
image based on the ever popular theme of good versus evil. Taking an 
alternative approach to the subject and breaking a few rules along the 
way, he takes us through the process from conception to final detailing 
over on p.104.

To wrap things up, please check out our Sketchbook feature with concept 
artist, Julia (Falinor) Udalova. And in the spirit of Halloween, we love 
James Wolfe Strehle’s The Twisted Room gallery image; we’re also 
honored to have work by Hyung Jun Kim and Alex Broeckel, and many 
others in this month’s gallery on p.40. Enjoy!

http://www.2dartistmag.com


Contributors

Setting up your PDF reader 
For optimum viewing of the magazine it is recommended that you have 

the latest Acrobat Reader installed.  

You can download it for free here:  DOWNLOAD!   

To view the many double-page spreads featured in 2DArtist magazine, 

you can set the reader to display ‘two-up’, which will show double-

page spreads as one large landscape image: 

   

1. Open the magazine in Reader;   

2. Go to the View menu, then Page display;  

3. Select Two-up Continuous, making sure that 

Show Cover Page is also selected.

Get the most out of your 

Magazine!
If you’re having problems viewing the double-page spreads that we 

feature in this magazine, follow this handy little guide on how to set 

up your PDF reader!

http://www.adobe.com/products/acrobat/readstep2.html
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Contributing Artists
Every month many artists around the world contribute to 3DCreative and 

2DArtist magazines. Here you can find out more about them. If you would 

like to be a part of 3DCreative or 2DArtist magazine, please contact: 

lynette@3dtotal.com

Kirsi 
Salonen

An artist from Finland, who 

mostly laughs a lot, despite the 

dark artistic depictions in her 

work suggesting otherwise. 

When she’s not working, she’s often smacking 

console games, listening to music, or watching good 

movies. Her motto in life is best described by the 

words of the great band, Placebo: “Eradicate the 

schism”. She tells us that this phrase says just about 

everything she wants to accomplish as both an artist 

and a person.

www.kirsisalonen.com | salonen.kirsi@gmail.com

Carlos 
Cabrera  
Argentina-based digital artist, 

concept artist and illustrator. 

He’s has been doing concept 

art and character designs for 

videogame companies in Argentina and around the 

world for about six years, during which time he’s 

launched a successful free video tutorial series, 

Watch and Learn, for the community. He’s been 

doing art all his life, since a child, gathering a few 

good skills from his art direction and digital painting. 

www.carloscabrera.com.ar

carloscabrera@gmail.com

Jason  
Seiler
Has had the pleasure of 

painting for many magazines, 

such as TIME and MAD. 

He’s also worked on films for 

Universal Pictures, and more. He teaches a course 

on caricature illustration for Schoolism.com, and 

last year his first book came out, called “Caricature, 

the Art of Jason Seiler”. His second book, “Seiler 

2008-2009” will be available this July, as well as a 

two-hour instructional DVD, “Sketching with Jason 

Seiler”. 

www.jasonseiler.com | jseiler@jpusa.org

Nykolai 
Aleksander

Born in Germany in 1978, she 

moved to England in 1999, 

and currently lives in South 

Africa with her husband. She’s 

been painting digitally since 2002, and works as 

a freelance illustrator for both private clients and 

companies.

 

 

 

www.admemento.com 

x@admemento.com

Would You Like to Contribute 
to 3DCreative or 2DArtist 

Magazine?
We are always looking for tutorial artists, gallery submissions, potential 

interviewees, “making of” writers, and more. For more information, 

please send examples of your work, or a link to your online portfolio, to: 

lynette@3dtotal.com

http://www.2dartistmag.com
mailto:lynette@3dtotal.com
http://www.kirsisalonen.com
mailto:salonen.kirsi@gmail.com
http://www.carloscabrera.com.ar
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mailto:lynette@3dtotal.com
mailto:lynette@3dtotal.com
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Oleg 
Matsokin
A 31-year old concept artist 

residing in Moscow, Russia. He 

has been working in the games 

industry for over five years, 

currently working at Astrum Online Entertainment as 

a full-time lead artist where he is focused on concept 

art, illustration, and creating visual style solutions 

for games. He’s keen on traditional drawing (paper, 

pastel, pencil, charcoal, crayon), as well as digital 

art, and he also enjoys traveling and looking at 

ordinary things from different angles. 

www.matsokin.com | oleg@matsokin.com

Mark  
McDonnell 

A self-taught designer 

working in the animation 

and entertainment industry, 

specializing in a wide variety 

of skillsets such as character design, layout design, 

look development, graphic design, and as an 

instructor. He recently published The Art and Feel of 

Making It Real: Gesture Drawing for the Animation 

and Entertainment Industry, and he has worked for 

studios that include Walt Disney and Pixar, amongst 

many others.

www.cre8tivemarks.com | cre8tivemark@aol.com

http://www.2dartistmag.com
http://www.3dcreativemag.com
http://www.matsokin.com
mailto:oleg@matsokin.com
http://www.cre8tivemarks.com
mailto:cre8tivemark@aol.com


From drawing caricatures of his grade school history 

teacher, to drawing caricatures for The New York 

Times, Jason Seiler’s career has gone from 

strength to strength over the last couple of 

years. We recently caught up with him to 

discover more about the art of caricature, 

his fascination with ducks and who his 

dream caricature subject would be.  

“What I try to 
do is capture a 

person’s essence; 
I try to capture 

their character. By 
exaggerating and 
pushing elements 

of truth, I enhance 
both the subject’s 

likeness and 
essence”
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Jason Seiler Interview

Interview with Jason 
Seiler

Hi Jason and welcome to the pages of 2DArtist! 

Now for a young guy, you have a seriously 

impressive resume; you’ve done work for 

Universal Pictures, TIME and The New York 

Times; you swept the board at the last ISCA 

(International Society of Caricature Artists) 

convention, winning too many awards for me to 

list here; you’ve had books and DVDs published 

… but what I’d like to know is: how did it all 

begin? How did you take your first artistic steps 

to reach where you are today? And was your 

first commission really from your grade school 

principle [Laughs]?

My father is an artist as well, so I grew up 

surrounded by his drawings and paintings and 

was very young when I was first influenced by 

the idea of art. As a wildlife artist, he painted 

a lot of waterfowl for duck stamp competitions 

and because I probably thought I wanted to be 

an artist just like him, by the age of two I was 

drawing recognizable ducks with crayons and 

I knew their names as well. To this day I can 

still name almost any kind of duck I see! In fact, 

most of my younger days were spent filling 

my sketchbooks with birds, animals and the 

occasionally shark. Actually, I became obsessed 

with sharks at one point and drew over 350 

different species in one book, listing their 

common and scientific names. My mom still has 

that book!

When I was seven, I began to get into drawing 

cartoon characters, like Bugs Bunny and Daffy 

Duck; I drew characters like this for years. Bugs 

Bunny turned into drawing the Ninja Turtles and 

from there I filled sketchbooks with Batman, 

Superman, and Spider-Man.  Around the age 

of 10, I was introduced to MAD magazine.  I 

rarely ever read it; I would mostly draw from it. 

Anything that looked fun to draw, I drew – mostly 

the work of Don Martin.  As I continued to draw 

from MAD, I started playing around with people, 

making them look more like “Don Martin” 

people, with big noses and funny feet. 

When I was 11 or 12, I started doing my first 

caricatures, although at the time I didn’t know 

there was a name for what I was doing. My dad 

was a youth pastor at the time and so I was 

drawing all the kids in my youth group. I would 

spend hours and hours trying to capture their 

likenesses from photographs that I’d taken.  

Soon after this I started drawing famous people; 

my first celeb caricature was of James Woods - 

my mom has that as well!  My dad soon realized 

that I was obsessed with drawing caricatures 

and bought me Lenn Redman’s book How 

To Draw Caricatures. It was at that moment 

that I realized what I had been doing wasn’t 

something I’d just come up with, and that it even 

had a name!  

My first commission for a “caricature” was 

indeed from my high school principle. I had a 

bad habit of always drawing on my homework 

and every once in a while I’d draw cartoons 

“She said I’d done a 
great job and told 

me that while it 
wasn’t a good idea to 
draw on my homework, 
I was very talented.”

http://www.2dartistmag.com




and caricatures of my teachers on my work, not 

thinking that they would eventually see what I 

had drawn. 

One day in history class my teacher, 

Mr Wentz, saw a drawing that I 

had done of him. He took me to 

the Principle’s office, the Principle 

excused him and when he left, she 

began to laugh. She said I’d done 

a great job and told me that while 

it wasn’t a good idea to draw on my 

homework, I was very talented. She 

called me back into her office a day or 

so later and asked if I’d be interested 

in drawing nine teachers for a retirement 

party. I said sure and I was paid $20 a person. 

It was then that I started to think that maybe I 

could draw caricatures for a living. And that’s 

how all of this started.

It sounds like it was a pretty natural transition 

for you to move from caricature 

as a hobby to caricature as a 

potential career path. What was this 

transition like in reality? And just how 

difficult was it to turn that hobby into 

a sustainable career? 

I had already been doing caricature 

and portraiture all the time, on my 

own time. As I slowly became known 

for what I was doing I would take on 

more and more “side jobs”, drawing for 

commission whenever I could. 

Eventually my “day job” was not only 

depressing for me to be at, but it was no 

longer needed.  Everything changed after 

I did a small piece for TIME magazine. That 

job “officially” changed my career. Soon after 

I began working for magazines and haven’t 

stopped since.

The difficulty for me in all of this was doing 

“gift caricatures” for people. I hated doing 

them because for me it wasn’t “real” art, or at 

“I paint what I 
want, how I want, 

I charge what I 
want, and there’s 

no deadline“

least it didn’t feel like it. I didn’t want to draw 

people and their pets, or their request. People 

would want to be boxing Mike Tyson or flying 

an airplane.  I realized soon that this sort of 

work was for a different kind of artist. I still take 

private commissions, but now I paint what I 

want, how I want, I charge what I want, and 

there’s no deadline, I finish when I can. It 

works better because this way I draw 

and paint naturally and I create an 

original piece of art that the client is 

happy with.
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The evidence of your talent for caricature is 

clear from looking at your portfolio and your 

websites. So I guess the natural next question 

is: why caricature? What is it about this area 

of art that captivates you so much? What key 

features are you looking for in the people you 

choose as subjects and how do you go about 

transforming someone into a caricature?  

This is a good question. The funny thing is I 

don’t consider myself a “caricaturist”. I’m an 

artist and I have a passion for portraiture. 

My portraits are stylized; some exaggerated, 

some funny, and some not so funny, like my 

oil portrait of Saddam. I can draw and paint a 

straight portrait, but that’s not as interesting 

to me. What I try to do is capture a person’s 

essence; I try to capture their character. By 

exaggerating and pushing elements of truth, 

I enhance both the subject’s likeness and 

essence. I feel that what I do is a lot like 

impressionism; when I look at a person, really 

what I’m painting is my impression of them. 

Sometimes it may look like a straight portrait – 

there’s no need to exaggerate anything – other 

times it may be created out of exaggerated 

shapes and form.

When I look at a person, I don’t look for any 

particular thing, or the “obvious” feature on 

their face. I study that person and find out 

what makes them unique. All the features on 

the face make a person unique and they’re 

all connected. I look for shapes and I focus 

a lot of my energy on the subject’s eyes and 

mouth. If it’s a person I’m familiar with, I look for 

references of that person which are similar to 

what comes to mind when I picture that person 

in my head. When it’s someone I don’t know 

well I surround myself with lots of photos and I 

do a lot more sketching and prep work.

What do you think is the best caricature you’ve 

ever produced? And what kind of tricks and 

techniques do you use?

Man, that’s a hard question! Honestly I don’t 

know; I don’t feel as though I have a favorite. I 

guess one of my favorite paintings is a recent 

http://www.2dartistmag.com


one I did of George Lucas. I don’t know if it’s my 

best caricature - I only like about a handful of the 

paintings I’ve done. The George Lucas is a 16”x20” 

acrylic on linen board. I enjoyed the time I spent while 

working on that painting and I have it framed and 

hanging in my studio. I’m not sure if I could 

ever sell it though because it has personal 

value to me; it won Studio Painting of the 

Year at the ISCA’s 2008 convention and 

then was chosen to be in Communication 

Arts Illustration Annual 50. I enjoy the work I do 

digitally, but when I paint with acrylics or oil I feel 

somehow connected to the painting. It’s then 

difficult for me to sell an original, no matter how 

much I may be getting for it.

I don’t really feel as though I have any tricks. When 

I paint with acrylics or oils I usually paint on primed 

panel or linen board. I like to use a limited palette; 

usually my palette is Black, Cadmium Red, Yellow 

Ochre, and White. I’ll sometimes add a bit of 

Ultramarine to my Black. 

My palette when painting digitally is very similar. 

I try to not use too much color, or at least I 

start off that way and slowly build. I use the 

paintbrush tool and that’s really about it. The 

important thing I do when painting digitally 

is to try and paint in a traditional way. I’ll do 

an underpainting of sorts and intentionally 

let colors pop through from earlier on. 

Other than this, I don’t feel I have any 

tricks; I’m not interested in abusing 

the computer or what it can do and I 

don’t want my digital paintings to look 

digital. It’s the greatest compliment 

when someone has to ask what 

medium a painting was done in. I was 

approached by many people at the ISCA 

convention who thought my George 

Lucas was a digital painting. I had brought 

the original with me for people to see and they 

were amazed that it had been created with “real” 

paint and “real” brushes.

“It’s the greatest 
compliment when 

someone has to ask 
what medium a painting 

was done in.”

Now I know you’re involved in Imaginism 

Studios’s “Schoolism” project. For those readers 

who might not be aware what Schoolism is all 

about, could you just give us a quick overview? 

And what has been your experience of the 

service as a whole?

Schoolism was started by Bobby Chiu, an 

amazing artist and a good friend. It’s a place 

to study if you’re serious about becoming 

a better artist in your particular area of 

interest. All the instructors are well-

known and established in their 

professions. If you want to learn 

about storyboarding, for 

example, you can learn 

directly from Kris 

Pearn who’s 

been the head 

storyboard 
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site, I download their work and begin my 

critiques. For my critiques, I work on a PC 

tablet and in this way I can draw and paint right 

onto the screen and record the whole thing. 

My critiques are usually 25-30 minutes long. 

The students then download a video file of me 

drawing and painting, sometimes over their work 

and sometimes starting from scratch to teach 

them how I would go about it. It’s a one-on-one 

correspondence course. 

Most of the painting I cover in this first course 

deals with values and the importance of 

understanding values. I’m currently working 

on a new course that will most likely start this 

coming fall.  My new course will be “Painting 

artist on films like Surf’s Up or Open Season. 

Or you can take Stephen Silver’s class on 

character design. Stephen is one of the main 

character designers for Nickelodeon and many 

others. It’s an amazing concept; you, as the 

student, get to learn from an artist who is an 

expert in his field!

I currently teach a course on caricature, where 

I teach drawing and some painting, and cover 

exaggeration, likeness, humor, shape and 

capturing a person’s essence. The way it 

works is like this: each semester I accept only 

15 students and then for my class, there are 

nine lessons, each around two hours long. In 

those lessons there are demonstrations; I do 

several drawings and paintings, all the while 

breaking down my thought process and sharing 

my techniques. Each assignment then has 

homework that the student can download and 

which they have up to 10 days to complete. 

Once finished they upload it to the Schoolism 

with Jason Seiler” and it will be an intense nine 

weeks. I’ll mix traditional with digital and teach 

my approach to painting.

So far the experience has been really great. 

The best part about teaching at Schoolism is 

watching a student really grow and improve 

as an artist. I take on every level of talent. I’ve 

had students who were already quite good 

and others who could barely draw. I take each 

student on personally and if I have to make 

adjustments in order for them to learn and 

grow, I do. I’ll sometimes change the course a 

bit for a particular student; it becomes personal 

this way. If the student works hard and pushes 

themselves, they will hopefully come out of 

“The best part 
about teaching at 

Schoolism is watching 
a student really 

grow and improve as 
an artist.“

http://www.2dartistmag.com
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my course with a publishable piece of art, 

or if not then they will certainly have a new 

understanding of what it will take for them to be 

able to do that.

Wow that sounds intense! Do you have any 

advice for potential students thinking of taking 

one of your courses? Is there anything they can 

do in preparation to make sure they get the very 

best out of their chosen course?

Sure, my advice would be to do more than 

what I ask. If I assign two to three sketches of 

a person, do ten sketches. Always do more, 

push yourself to the limit as much as you can. 

Really, if a person does the work and more and 

communicates with me and shares their process 

- if they can be honest with themselves - they 

will improve and complete the course a much 

stronger artist. I’ve had many students who were 

good, but now after taking the course they’re 

really good and I couldn’t be more proud. 

It’s why I continue to teach. It’s always good to 

humble yourself, become “teachable”. I’ve had 

some students who were talented, and knew 

they were, and because of this they thought they 

had nothing to learn and therefore didn’t grow 

or improve at all. Other students, who may not 

have been quite so good, passed them towards 

the end.

In your blog you mention that you’re currently 

working on a sketching DVD. I imagine that’s 

quite a full-on process; just how do you go about 

making a DVD? Were you commissioned to 

produce it, or is it a personal pursuit?

The DVD is called Sketching with Jason 

Seiler. It’s not an instructional DVD on how 

to draw caricatures – although I do draw a 

lot of caricatures or portraits – it’s more of an 

inspirational DVD where I share my drawing 

and sketching techniques. The DVD will cover 

shape and form, cross hatching, thumbnails and 

their importance, digital painting and digital paint 

sketching, ball point pen sketching, watercolor, 

and much, much more. I share a bit about 

http://www.2dartistmag.com
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caricature and my thought process; I draw several people while talking the 

whole time... but like I said, it’s not intended to be a caricature instructional 

DVD. I feel it will relate to many artists in many different areas of drawing, 

from comics to portraiture.

Creating the DVD was a huge deal. It was a lot of work and I did all of it on 

my own. I’ve gotten many requests over the years to do a DVD and I felt 

that a DVD on sketching would be the best thing to start with because as 

I think it’s important to establish a strong foundation by nailing sketching 

and drawing before you get too far into painting.

The DVD is high quality and two hours long, with a bonus video of me 

flipping through some of my sketchbooks, as well as a painting gallery and 

a sketchbook gallery. My friend Nathan makes music videos for bands and 

we worked on the DVD for about three months, filming hundreds of hours 

of drawing and painting. We then spent about two and a half weeks editing 

it all together. Because I used to be in a number of bands and know a lot 

of musicians, I was also able to get professional musician friends of mine 

to write music for the DVD.

The DVD looks and sounds really good and I’m 

very proud of how it turned out. Most 

instructional videos that I’ve seen 

are cheesy, have bad music and 

the film quality isn’t all that 

great either. I told Nathan 

right off the bat what 

kind of DVD I wanted to make and I’m happy to say that we achieved it, 

with a really top-notch look and great sound. The only thing that I’m not 

happy with is my own voice … I can’t stand the sound of it!

When can we expect this DVD to be released? And do you see 

anymore DVDs in your future, or has all the hard work put you off 

[Laughs]?

The DVD and my new book have both been released and they’re both 

selling quite well! The most exciting thing for me is that I’m selling quite 

well internationally. It’s great sending my work to Iran and Egypt one 

moment and then to Japan or Belgium the next. I do plan on making more 

DVDs and books in the future and I think my next DVD will 

probably be on painting. I’m also working on another project that will be 

quite different, more of a short film in book form. I’m very excited about it.

My DVD and book can be found by going to my store on my website, or 

by going directly to: www.jasonseilerdepot.blogspot.com

One final question before you go: if you could produce a caricature 

of anyone in the world, to hang on their wall for all to see, who 

would it be of, and why?

I don’t know … this is a hard one. I think maybe Conan O’Brian; 

I think he’s hilarious, he’d be fun to paint and it would be cool 

to know he enjoys a painting that I did of him.

http://www.2dartistmag.com
http://www.jasonseilerdepot.blogspot.com


Jason Seiler
For more work by this artist please visit:

http://www.jasonseiler.com/

http://www.levycreative.com/portfolio.php?pid=192

http://www.imaginismstudios.com/our-art/jason-seiler 

http://www.jasonseilerillustration.blogspot.com/

http://www.schoolism.com/ 

Or contact them at:

jseiler@jpusa.org  

Interviewed by: Jo Hargreaves
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for more products in our range visit http://www.3dtotal.com/shop

: volume 4

Buy the book to see just how 
they create their incredible 

imagery!���

Features 50 of the finest digital 
2d and 3d artists working in the 
indusrty today, from the likes of:

Loïc e338 Zimmermann | James Paick

Craig Sellars | Jelmer Boskma

Maciej Kuciara | Daarken| Marek Denko 

Kekai Kotaki | Andrew Hickinbottom 

Marek Okoń

“Digital Art Masters is getting 
better and better at showcasing 

some of today’s best digital 
artists. The way the book shows 

the processes of achieving 
great pictures provides a good 

opportunity to learn from these 
artists, and keeps you challenged 

in your own Art.”
Raphael Lacoste | www.raphael-lacoste.com/

Hardback - 21.6cm x 27.9cm in size 

288 Full Colour Premium Paper Pages 

ISBN: 978-0-240-52171-8

http://www.3dtotal.com/damv4


Julia Udalova, otherwise known as Falinor, is with us this month to take us through some of her recent sketchbook additions, covering cute designs for children’s games, a clumsily-built goblin city, and mysterious female heroines. Sit back, and enjoy!

“Whilst working on designs for 
goblin architecture, it came 
to me that goblins could 
even cut caves straight 
into the rock and build 
additions over them, just 
like the residents of 
the ancient city of 
Matera 
do.”
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Hi, I’m Julia (Falinor) Udalova, I currently work as a 

lead concept artist designing characters, locations 

and objects, and this is my sketchbook! 

Drawing characters, backgrounds, interface 

elements, smilies, icons, and even comics are within 

the scope of my activities in my role as concept 

artist. At present, I’m working on an on-line project 

for children, where all the characters and animated 

objects are vectorized – creating vector characters is 

also one of my many jobs. 

When designing a character for a game I find that 

you should always consider not only the age of your 

audience, the genre and the type of game, but you 

should also keep in mind how the character will be 

animated, and its movements. So to start things off 

I’d like to first of all tell you about some sketches 

and characters I’ve designed recently for a children’s 

game.

Sketchbook of 
Julia (Falinor) Udalova

http://www.2dartistmag.com
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children, but I realized that the more fantasy or 

doll-like characters just didn’t fit with the brief. 

So I decided to run with the cute baby-faced 

designs, as marked with a tick in Fig.02. 

Children’s 
Characters
Let’s consider then an on-line project for 

preschool kids and their parents. For the 

children, I had to design characters – an 

avatar for the player (a boy or girl) and several 

“quest” animals. I initially designed the girls 

as shown in Fig.01, but they were too cheeky 

and grown-up looking for small children, and 

therefore the kids using the website wouldn’t 

have been able to connect with them. 

So I went through a number of children’s 

images to do some research and came to 

the conclusion that I should keep the style 

of character and the “fidgetiness” of them, 

but simply change the age range of them to 

something much younger, and more in keeping 

with the children who were going to be using 

them.

When working on a character I quickly design 

details, components, combine ideas, and 

sometimes complete some of the designs 

if I feel they’re working. With this particular 

project, in the end I had many different types of 

http://www.2dartistmag.com


page 23 Issue 046 October 2009www.2dartistmag.com

Julia (Falinor) Udalova Sketchbook

Images of small animals for a magic world can 

come from anywhere – a dream, folk tales; they 

could be inspired by watching a cartoon … One 

thing these animals needed though, for this 

particular project, were real animal features, 

to make it easier for the young players to dive 

into an unfamiliar world. I had to be sure not 

to forget about the age of the animals, too; 

they also needed to look young in character, 

because the game was for small children, after 

all. I also went ahead and designed some 

housing for the creatures, for different climates 

(Fig.03).

You’d think that a raven design would be 

easy, but actually there are lots of different 

ravens and I had to find one that worked. The 

first version in Fig.04 looks like a pelican; the 

second like a young jackdaw. So I continued 

searching for the right design, playing with 

proportions and characteristics, and eventually 

my raven turned into more of a sly and cagey 

character, which is very much in keeping with 

the real thing! 

http://www.2dartistmag.com
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changing the natural color to something more 

fantastical (Fig.05). 

A rabbit is a cowardly and slightly silly 

character. After designing ten rabbits, I chose 

to run with a brown one. He has a discouraging 

Likewise, a squirrel is a cheeky nut beggar. In 

a magical world for small children, a squirrel 

could even be purple! The main thing I had to 

keep in mind with this one was that the basic 

appearance and characteristics remained 

recognizable as squirrel-like, even though I was 

expression and a face that completely 

corresponds to a quest which he gives to the 

player. The others are too aggressive or have 

acidic colors — a child might be frightened of 

such a mutant! (Fig.06)

http://www.2dartistmag.com
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I don’t just draw for children, though, so 

let’s now take a look at some sketches 

I’ve created for goblin architecture to 

move this article onwards!

Goblins
Goblins are stupid creatures. Their 

architecture is primitive and also slightly 

ridiculous. They use materials at hand, 

but they’re badly treated and clumsy 

looking. Goblins don’t care about beauty 

– only convenience matters (Fig.07 – 

09).

A goblin building could be constructed on a rock, to 

make it easier to defend. The mine, tavern, blacksmith 

could be settled in the same location – or perhaps 

even in rocky caves that form a small town that way 

(Fig.10).

Whilst working on designs for goblin architecture, it 

came to me that goblins could even cut caves straight 

into the rock and build additions over them, just like 

the residents of the ancient city of Matera do (Fig.11).

http://www.2dartistmag.com
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Or they could build structures of stone, with 

logs and planks, constructing massive buildings 

that look like boxes with lots of useless 

elements to them (Fig.12a-12c).

And so, from various initial ideas I started work 

on the sketch for a goblin town. At first it was 

just a spot with a pair of houses and a bridge. 

Then the spot turned into a rock and useful 

buildings began to appear. As a result, there 

appeared a blacksmith, a tower, a monastery, 

a shaft, and other necessary buildings (Fig.13 

– 14).

 

Goblins are such funny, foolish beings – and 

huge fans of beer and toys (Fig.15)!

http://www.2dartistmag.com
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Female 
Characters
Even a villain can be sexual: positive, brutal… 

A female character will look cooler if, to her 

beauty and brutality, you add a zest that makes 

her different from other heroines. For example, 

it could be a firm gaze, good posture, or 

deliberately negligence – it’s all in your hands!

General Ainia, who I painted for the Dominance 

War competition, looks tired and a little cold 

hearted (Fig.16 – 17). War is her work, and the 

portrait reflects that in her character – she’s a 

militant woman, in armor, with a firm gaze and 

a determined posture.

A heroine could even be airy, just like this fairy 

(Fig.18). The main thing is that the character 

has unique features which stand her apart 

from others. Don’t you think that a heroine with 

character and history is far more interesting 

than just another empty beautiful picture…? 

Well, that’s about it from me, I hope this insight into my sketchbook has been interesting, and I 

wish you every success with your own concepts. Thanks for reading!

Julia (Falinor) Udalova
For more information please visit

http://www.falinor.com

http://www.falinor.blogspot.com 

or contact

falinor4eg@gmail.com

http://www.2dartistmag.com
http://www.falinor.com
http://www.falinor.blogspot.com
mailto:falinor4eg@gmail.com
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If you haven’t heard of Jason Manley, we’re sure you’ll have heard of his company Massive 

Black; it’s one of the premiere entertainment art and animation studios in the world with 

branches in San Francisco, Shanghai and Bangkok. As you can imagine Jason is an incredibly 

busy guy, but at long last we managed to catch up with him to bring you this interview.  

“Comes back to that 
old saying...”Do what 
you love and the 
success will come”.”
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doing next-gen work in the industry, as well as 

the first to truly offer all the art work that games 

or entertainment needed, under one company 

banner. Jobs rolled in fairly quickly. 

We really focused on games since Andrew, 

Coro and I were the first three partners, and 

games were in our blood. We saw the industry 

heading toward outsourcing and external co-

development. We knew if we could get great 

people together we would be seen as the only 

group who did a great job... at least that was the 

hope! At the time the work clients outsourced 

elsewhere came back to them ruined or sub-par 

in almost all occasions.  

No western publishers had that set up, so we 

decided to go after it. Concept Art was all done 

in-house at the games studios, except for some 

occasional freelance stuff like Bungie did with 

Mullins or the like. Really it seemed like a smart 

biz move to offer team-based, high quality, art 

and assets. We spent two years setting up the 

first solid pipelines with the publishers and then 

watched as 300 other companies sprung up 

to compete with us [Laughs]! We fought hard 

though and managed to land more clients than 

most of our top ten competitors combined. It is 

not easy work, but it is what we set out to build.

Yeah, it moved quickly. We were the only 

ones doing it, so we got a great jump from the 

beginning. We wanted to work with the top 

clients in the field and we only wanted to work 

with top talent at the studios - plus we wanted 

to work on all the best projects. Over the years 

I have turned down quite a few projects, just 

“We wanted to work with the top clients in 
the field and we only wanted to work with 
top talent at the studios - plus we wanted 

to work on all the best projects.”

Massive Black
Hi Jason, great of you to take time out of your 

busy schedule to chat with us! Can you start 

off by telling us about the idea behind Massive 

Black; was there one single moment that 

triggered it all off? And did it snowball very 

quickly after that?

Massive Black got going in late 2002, about 

eight months after I first set up ConceptArt.org. 

In the past I had tried to get high quality art done 

outside of the companies I worked with and 

every time I used an outside group, the art that 

came back was terrible. It was missing quality, 

heart, and soul. There was no place to get good 

stuff except for from individual artists working 

freelance. The industry was not outsourcing 

much work at the time, peanuts really. I 

recognized that the industry would have to start 

working that way due to growing team sizes, 

and I had gotten so busy with freelance work 

that I had to start farming it out to friends just to 

get it all done. That work is what built our remote 

pipelines, some of which we still use today. We 

made the decision then to be the first concept 

art studio for the games industry. Within weeks 

we had attracted some big name 3D artists and 

animators and that rounded out the company 

and widened our capabilities. We were going 

to be the first full service art outsourcing studio 

http://www.2dartistmag.com
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because it was so important to have a great 

track record and credit list. We were very 

selective and did not lose a bid for the first 

couple years in business. We took our time to 

build it all... one brick at a time. 

That stuff is only one side of the business. We 

began offering the same kinds of services to 

toy, film, comic, TV and social game companies, 

as well as online clients. At the same time we 

began working on our own worlds under our 

Massive Black Entertainment banner. Those 

projects are just now beginning to take shape.  

We built seven foundations for entire worlds and 

we’ve finally selected two to move further into 

production with. 

Finally, the other side is related to the main 

reason we decided to go into business and to 

build companies together. I only wanted to work 

around talented people. I’d had my share of 

both experiences: working with mediocre talent 

and also working with talent that exceeded my 

own. When the latter case happened, I learned 

very quickly. We all did back then and still do 

now. The motivation was not money when we 

got started, as much as it was realizing our 

dreams of working together closely, learning, 

growing and finding fresh ideas. Fortunately the 

studio has been successful. Comes back to that 

old saying... “Do what you love and the success 

will come”. I remember being told that turning 

down one of the biggest jobs that crossed our 

http://www.2dartistmag.com
http://dot-matrix-interactive.com/Our_Games.html
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path was “crazy and stupid” by three studio 

heads at an industry meeting. All three of those 

companies are no longer around.  

What’s a typical day like for you at the studio, or 

is there such a thing as a typical day?     

Wake at eleven AM central. Emails, Red Bull, 

snack, more emails, check industry news, check 

ConceptArt.org, work on a few contracts and 

keep companies from giving us a raw deal (I 

do our legal and biz stuff here), then jump into 

managing clients, grab some lunch, head back 

to emails and building the new businesses... and 

that is just getting started [Laughs]! 

I spend a few hours working on our new 

companies, business plans and programs for 

the upcoming online school for ConceptArt.org. 

After that I deal with clients, check all the MB 

work done that day and try to manage the IMs 

and emails and phone calls. By 9PM it is calm.  

That is when I begin to get the most done. I 

spend a ton of hours each day volunteering in 

ConceptArt.org and take breaks for food, fun, 

and to walk my dog. I work a ton though - 77 of 

78 days, with one day off - but that is my choice. 

I feel lucky to be busy right now, given the 

state of the economy, so I put in the hours. The 

remaining time goes into workshops and other 

stuff I really like to do. Get a late dinner. By six 

“I work a ton - 77 of 78 days with one day off 
- but this is my choice. I feel lucky to be busy 

right now, so I put in the hours.”

http://www.2dartistmag.com
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the moment I’m really excited about the work I’m 

doing for ConceptArt.org with a core team here 

in Austin. We see it as the future of online life 

and I expect to keep working on this project for 

years to come. The upcoming online technology 

update for ConceptArt.org 4.0, and the online 

school we’re building - TheArtDepartment.org 

or seven AM I am back sleeping. Then it starts 

all over. Fortunately, I love what I do!

I really do not want to sleep but have to keep 

pushing to get just enough and that’s it. I want 

to keep seeing good things happen and really 

enjoy all aspects of what I have been doing.  At 

- are just small parts of the overall picture. The 

coming years are going to be worth all the time 

we have put in, that much is for sure. 

At what point in your growth did you decide 

to have your satellite teams in Bangkok and 

Shanghai? How important is their role in the 

bigger picture of your business?

Both teams are instrumental in our 3D 

development. BKK handles LOD, hand painted, 

PSP, PS2 and casual games work; they are 

ace at that stuff. Shanghai does the next-gen 

stuff and is the HQ for our Asian operations. We 

chose teams in both locations for one reason: 

we believed it would be easier to train artists 

to use the software than do as others were 

doing and get guys who could use software but 

had no clue how to be an artist. We knew that 

Thailand had a history of very skilled artisans, 

wood carvers and sculptors, and that China 

had the top state-level art education programs 

in the world, so these countries were our first 

choices for that kind of growth. We had no idea 

both would become hubs for outsourcing or the 

like. We were just finding great people and didn’t 

care where they lived.

http://www.2dartistmag.com
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Okay, play time now: I can see you guys 

like your table tennis (same as us here at 

3DTotal), so if our team is ever visiting then 

we’ll challenge you to a game! Firstly, are you 

confident of your team’s ability to be victorious? 

And secondly, what else do you get up too when 

you’re taking a break from the screens?  

Come by MB SF or MB Shanghai and someone 

will take your challenge - no doubt about it! 

There are a few guys that are exceptionally 

good at table tennis… and if they lose it can 

revert to a Street Fighter match and winner 

takes all [Laughs]! I imagine you would all do 

well in both - no clue who would win!

I travel a ton. I have been all over the world 

these past six years; I’ve lived in Asia, traveled 

throughout Europe and the US and enjoy all 

that. I go and see a lot of live music, walk my 

dog, and well... date... read... go for a run. It 

all just depends what day it is and what kind of 

mood I’m in.

Can you tell the readers about any projects 

that you are particularly excited about at the 

moment?  

The project I am excited about right now is the 

www.artdepartment.org online school stuff. 

We have an absolutely beautiful program in the 

works and it covers all aspects of education. We 

are going to be offering the most comprehensive 

online and digital art school program anywhere.  

The instructor list is amazing. The content is 

coming along well. It is a game changer, for 

sure. I am stoked! 

As you started out as a freelancer, what are 

the major differences a company can expect 

to receive when commissioning work though 

a studio of your size rather than through a 

individual freelance artist?  

Speed, availability, quantity production... 

Don’t get me wrong; freelancers are great. 

I’ve been one. It is just hard to do a batch of 

150 paintings, 300 models/textures and 6000 

animations if you are just one guy.

Amazing art, DVDs and now your book... what 

else can we expect to see in the future?

We just hope to keep pushing into new areas 

and to keep learning more along the way. MB 

worlds will begin to be released in various forms.  

ConceptArt.org is launching the online 

educational program I mentioned, as well as a 

handful of other great services, and we have our 

www.conceptart.org/workshop event coming 

up in Europe at the end of the year. 

There is a lot more coming from these groups 

over the next few years. I look forward to it.

Thanks again Jason, and we’ll speak to you 

again soon!

Thanks for the time too. It’s been a pleasure!

Jason Manley
For more work by this artist please visit:

http://www.massiveblack.com 

Or contact them at:

jmanley@massiveblack.com

Article courtesy: Tom Greenway
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Welcome Home
Alex Broeckel

http://www.alexbroeckel.com

alexbroeckel@gmail.com 

(Below)

Foggy Evening
Lubos de Gerardo Surzin

http://www.degerardo.com

gerardo_de@yahoo.co.uk

(Right)
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Indian Tea
Sasha Podgorny

http://gorec.by

sashagorec@gmail.com

(Right)

The Twisted Room
James Wolf Strehle

http://jamiestrehle.com/

jameswolfstrehle@yahoo.com 

(Left)
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Lotus and Girl
Mingjuan Zhong

clown.cg@hotmail.com

mailto:clown.cg@hotmail.com


Short Break
Hyung Jun Kim

http://kjun.org/

kjunorg@gmail.com

© Hyung Jun Kim

http://kjun.org/
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Eastern Dragon Rider
Ghassem Farhany

http://www.no1hellangle.deviantart.com

gh_farhany_cg@yahoo.com

(Above)

Stacked City
Matt Ellis

http://www.mattpainting.com

matellis17@gmail.com

(Below)
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Hot House
Kenichiro Tomiyasu 

http://bearing.ws/demo

supernova1031@gmail.com
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Ghembel
Kian Kiani

http://kiankiani.cgsociety.org/gallery/

studio.bimz@gmail.com
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Introduction: 
The ‘Digital Art Masters: volume 1’ book, is 

a collection of work from artists which 

have featured in the gallery of 3DTotal. 

Spread over 192 pages, the book features 

some of the finest digital 2D and 3D art-

work that you can see today, from artist 

as Natascha Roeoesli, Philip Straub, Rob 

Chang, Jesse Sandifer, PiSONG, Meny Hilsen-

rad and Ryan Lim and many more. More 

than just any other gallery book, each 

artist has written a breakdown overview, 

each with supporting imagery of how they 

made there piece of work.

for more products in our range visit http://www.3dtotal.com/shop

The first book in the “Digital Art Masters” series, 
contains work by the following artists: 

André Holzmeister, Andrey Yamkovoy, Balazs Kiss, Cetin Tuker, Daniele Montel-

la, d’Ettorre Olivier-Thomas, Donald Phan, Drazenka Kimpel, Egil Paulsen, Eric 

Wilkerson, Fabricio Micheli, Francisco Ferriz, Fred Bastide, Fredrik Alfredsson, 

Haure Sebastien, Jesse Sandifer, Jorge Adorni, Juan J. González, Juliano Castro, 

Khalid Abdulla Al-Muharraqi, Landis Fields, Laurent Gaumer, Laurent Ménabé, 

Li Suli, Linda Tso, Marcel Baumann, Marco Siegel, Mariska Vos, Meny, Hilsenrad, 

Natascha Roeoesli, Nicolas Richelet, Niels Sinke, Norbert Fuchs, Olli Sorjonen, 

Omar Sarmiento, Patrick Beaulieu, Philip Straub, PiSONG, Richard Tilbury, Rob 

Adams, Robert Chang, Romain Côte, Ronnie Olsthoorn, Rudolf Herczog, Ryan 

Lim, Siku and Thierry Canon

: volume 1

http://www.3dtotal.com/damv1
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Vancouver Film School alumni credits include Across the Universe Geeta Basantani, Digital 
Compositor Alias Scott Dewis, Visual Effects Artist Babel Luis Blackaller, Storyboard 
Artist | Lon Molnar, Visual Effects Supervisor Battlestar Galactica Daniel Osaki, Lead 
Modeler | Megan Majewski, 3D Animator | Alec McClymont, 3D Artist Bioshock 2 (VG) Jacob 
Palmer, Animator Bolt Lino Di Salvo, Supervising Animator/Voice of Vinnie Charlotte’s Web 
Aruna Inversin, Digital Compositor | Adam Yaniv, Character Animator | Tony Etienne, Lead 
Lighter | Kristin Sedore, Lighter The Chronicles of Narnia: Prince Caspian Andreas Hikel, 

Pre-Visualization Artist | Christoph Schinko, Character Animator | Jami Gigot, Senior Layout 
Artist Cloverfield Nicholas Markel, Pre-Visualization Supervisor Constantine Aruna Inversin, 

Digital Compositor The Dark Knight Pietro Ponti, Lead CG Lighting Artist Dead Like Me Daniel 
Osaki, Visual Effects Artist | Alec McClymont, 3D Artist Diablo III Alvaro Buendia, Cinematic 

Artist | Steven Chen, Cinematic Artist District 9 Neill Blomkamp, Director | Shawn Walsh, Visual 
Effects Executive Producer | Jelmer Boskma, Modeler | Bernhard Kimbacher, Visual Effects Data 

Coordinator & Compositor | Julianna Kolakis, Creature Texture Painter | Adam Marisett, Visual Effects 
Artist | James McPhail, Visual Effects Technical Director | Dominic Cheung, Lighting Technical 

Director | Grant Wilson, Animator | Joey Wilson, Modeler Family Guy Michael Loya, Storyboard Artist 
Fantastic Four: Rise of the Silver Surfer Arun Ram-Mohan, Lighting Technical Director | Shawn Walsh, 
Visual Effects Executive Producer | Jessica Alcorn, Compositor Gears of War (VG) Scott Dossett, 
Animator G.I. Joe: The Rise of Cobra Allen Tracy, Visual 
Effects Editorial Supervisor Aruna Inversin, Digital 
Compositor | Jeremy  Stewart, Senior Animator | Jelmer 
Boskma, Modeler The Godfather (VG) Kirk Chantraine, Motion Capture Specialist The Golden 
Compass Adam Yaniv, Animator | Chad Moffitt, Animator | Thom Roberts, Animator | Ben Sanders, 

Animator | Andrew Lawson, Animator | Matthias Lowry, Visual Effects | Tony Etienne, Look Development 
Justin  Hammond,  Lighter | Pearl Hsu, Effects Technical Director | Aruna Inversin, Digital Compositor | Fion 

Mok, Matchmove Artist Hairspray Lon Molnar, Visual Effects Production Executive Halo 3 (VG) Bartek Kujbida, 
Character Animator Happy Feet Ben Sanders, Character Animator | Thom Roberts, Character Animator Harry 

Potter and the Prisoner of Azkaban Shawn Walsh, Color & Lighting Technical Director Harry Potter and the 
Order of the Phoenix Pietro Ponti, Technical Director Harry Potter and the Half-Blood Prince Harry Mukhopadhyay, 

Lead Effects Technical Director Hellboy II: The Golden Army Christoph Ammann, 3D Sequence Supervisor Horton 
Hears a Who Arun Ram-Mohan, Lighting Technical Director | Brent Wong, Modeler Hulk Geoff Richardson, Visual 

Effects Editor I, Robot Daniel Osaki, CGI Modeler | Megan Majewski, Pre-Visualization Ice Age: The Meltdown Ben 
Sanders, Character Animator | Arun Ram-Mohan, Lighting Technical Director The Incredible Hulk Shawn Walsh, Visual 
Effects Executive Producer | Tony Etienne, Look Development Lead The Incredibles Daniel Holland, Animator Indiana 

Jones and the Kingdom of the Crystal Skull Henri Tan, Creature Technical Director Iron Man Adam Marisett, 
Visual Effects Artist King Kong Chad Moffitt, Senior Animator King of the Hill Michael Loya, Director Kingdom 

Hospital Daniel Osaki, Visual Effects Artist | Megan Majewski, 3D Animator | Alec McClymont, 3D Artist Kingdom 
of Heaven Shawn Walsh, Digital Compositor Left 4 Dead (VG) Nick Maggiore, Animator Letters from Iwo 
Jima Aruna Inversin, Digital Compositor Live Free or Die Hard Jessica Alcorn, Compositor Lord of the Rings 
Trilogy Chad Moffitt, Senior Animator Lost Scott Dewis, Visual Effects Artist Mass Effect (VG) Sung-Hun 
(Ryan) Lim, 3D Modeler Matrix: Revolutions Aruna Inversin, Digital Compositor Shawn Walsh, Color & 
Lighting Technical Director Master & Commander: The Far Side of the World Robert Bourgeault, CG Artist 
Metal Gear Solid 4 (VG) Josh Herrig, Artist | Yuta Shimizu, Artist The Mummy: Tomb of the Dragon 
Emperor Aruna Inversin, Digital Compositor Persepolis Marianne Lebel, Animator Pirates of the Caribbean: 
At World’s End Ben Sanders, Character Animator | Allen Holbrook, Animator | Aruna Inversin, Digital 
Compositor The Pirates Who Don’t Do Anything: A VeggieTales Movie Mike Dharney, Animation Supervisor 
Reign of Fire Lino Di Salvo, Animator Resident Evil: Extinction Joshua Herrig, Visual Effects Artist 
Robots Arun Ram-Mohan, Additional Lighting Rome Teh-Wei Yeh, Matchmove Artist Scarface (VG) 

Maya Zuckerman, Mocap 3D Generalist Shrek the Third Rani Naamani, Animator Shrek the Third 
(VG) Samuel Tung, Technical Artist Sin City Michael Cozens, Lead Animator Smallville Geeta 

Basantani, Lead Compositor Star Trek Aruna Inversin, Digital Compositor | Tom Piedmont, Digital 
Plate Restoration Star Wars Episode III: Revenge of the Sith Andrew Doucette, Character 

Animator |  Nicholas Markel, Pre-Visualization Star Wars: Knights of the Old Republic (VG) 
Arun Ram-Mohan, 3D Artist | Jessica Mih, Level Artist Stargate: Atlantis Daniel Osaki, 3D 

Animator | Megan Majewski, 3D Animator | Alec McClymont, 3D Artist Sweeney Todd: The Demon 
Barber of Fleet Street Jami Gigot, Concept Artist Terminator Salvation Teh-wei Yeh, Lighting 

Technical Director | Geeta Basantani, Digital Matte Painter Transformers: Revenge of the Fallen 
Bryan Jones, Compositor | Aruna Inversin, Digital Compositor | Henri Tan, Creature Technical Director 

Teh-wei Yeh, Digital Artist | Stephen King, Animator Twilight Geoffrey Hancock, Digital Effects Supervisor 
Unreal Tournament III (VG) Scott Dossett, Artist Valiant Robert Bourgeault, Lighting Technical Director 
WALL-E  Mark Shirra, Layout Artist | Bill Watral, Effects Artist | Daniel Holland, Production Artist 

Watchmen Lon Molnar, Visual Effects Supervisor World of Warcraft: Burning Crusade (VG) Carman 
Cheung, Animator Warhammer 40,000: Dawn of War II (VG) Ian Cumming, Senior Artist | Nathan 

Hocken, Lead Animator A Wrinkle in Time Aruna Inversin, Digital Compositor and many more.

Your name here.

VFS student work by Thiago Martins

http://vfs.com/animationvfx


This tutorial series will revolve around the use of 3d as a starting point for digital painting. In particular we will 

explore the value of Google SketchUp, a free program enabling users to quickly build 3d environments using 

a set of intuitive tools.

This technique is used by many contemporary artists and is used as a quick and effective way of establishing 

correct perspective as well as offering a moveable camera in order to experiment with compositions.

As a 3d package SketchUp is easy to learn and does not require hours of training and as an artist wishing 

to draw complicated scenes, this approach can prove a valuable starting point for producing a template on 

which to paint over.

“I’ve envisioned a 
sci-fi scene like the 
ones we used to see 

in the cinema back in 
the 80s.”

• Free Brushes
• Free Base Image

http://www.2dartistmag.com/tutorial_resources/issue_046_oct_2009/tutorial01/tutorial01_freeresources.zip
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Using Google 
SketchUp as a base 
for Digital Painting

Why use SketchUp?
Google SketchUp is a free programme enabling 

users to quickly and effectively build 3D 

environments using a number of intuitive tools. 

Unlike most 3D packages it is very easy to learn 

and does not require hours of training before 

decent results are achievable. It is very versatile 

and with regards to digital painting can prove an 

invaluable tool in swiftly establishing a correct 

perspective, as well as offering a moveable 

camera in order to experiment with alternative 

viewpoints and compositions. 

An object can be made and then duplicated 

any number of times, so if a structural element 

is repeated throughout your concept then this 

package can quickly and accurately create 

such arrays. It also has a simple-to-use lighting 

system that enables placement of the sun 

according to the month and time of day by 

way of slider bars, thus determining physically 

correct shadows that can be turned on or off at 

the click of a button. These functions mean that 

as an artist wishing to draw detailed or tricky 

scenes, one can use SketchUp as a valuable 

starting point to establish a “guide template” on 

which to paint over.

Installation
In order to install SketchUp, click on the link 

below and go to Downloads on the left hand 

menu. Select the free version which is currently 

version 7 (Fig.01). Choose your operating 

system and then follow the instructions. 

http://sketchup.google.com/

Once installed, click on the application shortcut 

and you will be prompted with the following 

dialogue box in which you are asked to choose 

a template (Fig.02). The scale and type of your 

scene will determine which you choose, but 

for the purposes of this tutorial we will select 

Architectural Design – Feet and Inches.

Toolbars and Menus
When SketchUp starts you will see a screen 

resembling Fig.03. From the main menu click 

on View > Toolbars > Large Tool Set; this will 

access more tools which will appear down the 

left margin. To change the display mode of the 

objects in the scene click on View > Face Style; 

this will show a number of options, as seen in 

Fig.04.

If you also check Views under View > Toolbars 

you will see six small house icons appear 

below your toolbar (Fig.05). These will provide 

quick access to orthographic views, as well 

as isometric. You will notice that I have also 

checked Face Style in the list (highlighted in 

green), which has added some cube icons to 

represent the display modes. 

This is basically where you can customise your 

workspace and add toolsets to speed up your 

workflow. For additional help go to Window > 

Instructor; this will open a window providing 

useful information on whichever tool you have 

currently selected.

http://www.2dartistmag.com
http://sketchup.google.com/
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Basic Navigation
The key orientation tools you will use to navigate 

in your scene are Orbit, Pan and Zoom, which 

you will find on the top toolbar and whose 

shortcut keys are represented by O (Orbit), 

H (Pan) and Z (zoom). These can be seen in 

Fig.06.

The main tools used to directly manipulate your 

objects are Move (M), Rotate (Q) and Scale (S). 

The Scale tool appears on the left hand toolbar 

which you will see highlighted if you press S on 

your keyboard.

Drawing Shapes
One way of using SketchUp is to create two-

dimensional shapes from which you can extrude 

three-dimensional objects. Select the top view 

and then the Line tool (Fig.07) and left-click in 

the viewport to begin drawing. You will notice 

that as you do so, the points will snap to the 

green and red axes, thus easily enabling the 

creation of right-angled structures.

When you finally close the shape by clicking on 

the initial point you will notice the shape turns 

blue, indicating a surface has been made; once 

a shape has become closed you can still edit 

it, however. Using the Line tool, add an internal 

rectangle (see top diagram in Fig.08). To now 

make this edge become part of the exterior 

shape click on the Eraser tool and then on the 

outside edge shown in red.

You can continue to cut into your shape or 

alternatively extend it outwards and then erase 

the necessary lines by using the Line tool 

(Fig.09). Here I have added a walkway and 

also a curved section using the Arc tool. You 

can also draw more organic shapes using the 

Freehand tool (Fig.10).

One other useful function, especially for 

architectural structures, is the Offset tool which 

is situated next to the Rotate tool. This enables 

a shape to be duplicated in order to create 

depth – perfect for drawing walls in a building, 

for example (Fig.11).

With an exterior wall depth, click on the large 

internal shape using the Select tool (black arrow 

on Toolbar) and hit delete. You can then select 

the Push/Pull tool and then click on the wall and 

raise it vertically (Fig.12). You will notice I have 

edited the section where the walkway adjoins 

http://www.2dartistmag.com
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To add lighting effects check Shadows which 

is above the Fog label, and to get more control 

over this function go to View > Toolbars > 

Shadows. This will place two slider bars on your 

toolbar which denote the month and time of day. 

By adjusting these you can control the position 

of the sun and direction of the shadows (Fig.16). 

There is a little icon to switch the lighting on or 

off, and besides this there is also another icon 

which opens up some extra parameters that 

the building using the Line and Eraser tools so 

that this was not raised along with the outer wall.

Three Dimensions
When a shape has been converted into 3D it 

can be edited further by using a combination 

of the Line and Push/Pull tools. If you move 

the Line tool along an edge it will snap to the 

midpoint between opposing edges (Fig.13). You 

can then make equally spaced cuts, as shown. 

These new shapes can be pushed inward or 

pulled outward, or alternatively a new shape can 

be drawn and this can then be manipulated.

In Fig.14 I have used the Offset tool to create 

a window shape in the far left rectangle. To 

create the same proportioned window in the 

other sections simply select the Offset tool 

and double-click in each rectangle. To create 

the arches use the Arc tool and then erase 

the horizontal join shown by the dotted line. 

To create windows use the Push/Pull tool to 

move the shapes inwards beyond the inner wall 

surface or until they disappear. 

Using a combination of the tools mentioned 

so far you will have the means through which 

to create and edit a wide range of forms and 

design detailed scenes.

Atmospherics & 
Lighting
You can add atmospheric perspective in the 

form of fog to your scene. Go to View and check 

Fog, as seen in Fig.15. You will notice that the 

edges on my building have also been switched 

off, which you can control in the menu under 

Edge Style > Display Edges. alter the tonal range of the shading. You can 

also control whether this affects just the object 

itself or the ground along with it and vice versa.

Additional Tools
A few other useful tools worth mentioning are 

the Tape Measure, Protractor and Dimension. 

The Tape Measure is used to draw guidelines 

which can then be traced over with the Line tool. 

In Fig.17 you can see that the tape measure 

http://www.2dartistmag.com
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has created the dotted lines which can be 

used as a guide to draw the windows an equal 

distance from the top and bottom of the block. 

To delete the lines simply use the Eraser tool.

The Protractor is used to create accurate 

angles. Move the tool to the point at which you 

wish to start the angle and you will see how it 

snaps to the three axes. Click to establish the 

correct plane and then click to begin the angle 

along the appropriate edge. Now you can set 

the angle using the guideline. In Fig.18 I have 

used the near corner as the starting point, which 

I will mirror on the opposite corner.

Once the guidelines are drawn, trace them 

using the Line tool, as with the Tape Measure. 

In Fig.19 you can see that the two angles have 

been drawn and then the Push/Pull tool was 

used to extrude a roof shape across the base 

block.

The Dimension tool simply adds a label to 

your scene, showing the distance between two 

points. Click and drag from A to B and then drag 

up or down to set your dimensions, once again 

using the Eraser tool to delete when necessary 

(Fig.20).

Cameras
The camera in SketchUp is initially placed at an 

average eye level height, so for example when 

you click on the Position Camera tool it will 

zoom in and appear around head height from 

the ground. In this sense scale is an important 

factor in your scene. 

In Fig.21 you can see a cross where I intend to 

position the camera, after which the viewpoint 

will resemble the inset image. The character has 

been placed in the scene to demonstrate the 

relationship between the scale of a character 

and the initial camera height. To adjust your 

camera, use the Look Around tool represented 

by the eye icon.

One final tool which may prove useful is the 

Section Plane tool which allows a view of a 

cross-section of your object. To use this click 

on the tool and then align the green icon to the 

corresponding plane or angle you wish to view. 

Then select the Move tool and click on one 

of the corner arrows and drag in the relevant 

direction (Fig.22).

This concludes our overview which I hope has 

at least introduced the main tools and their 

functions. There are of course further lessons 

to learn along with other tools and techniques, 

such as applying materials, but the main aim 

here is to introduce the interface and value of 

the software in terms of building a simple 3D 

environment which can then be used in digital 

painting. 

Richard Tilbury
For more from this artist visit:

http://www.richardtilburyart.com/

Or contact them at:

rich@3dtotal.com

http://www.2dartistmag.com
http://www.richardtilburyart.com
mailto:rich@3dtotal.com
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SketchUp Render Two

For my second render (Fig.02), I took away the 

edges and added more contrast to the image; 

you can see how the shadows pop up a bit 

more and the middle grey appears between the 

shadows and highlights. 

Photoshop
Add Color!

Now it’s time to add some color to our painting, 

so open up the image in Photoshop (or your 

favorite painting software) and add two new 

layers. Fill these layers with cold and warm 

colors. I fill the first layer with a blue (cold) and 

the second layer with a brown or sepia tone 

(warm). 

with understand the proportions and scale in the 

scene. 

Concept, Mood and Color

The next step is to use your imagination; you 

have to elaborate in your mind the mood of the 

painting you are about to work on. In my case, 

I’ve envisioned a sci-fi scene like the ones we 

used to see in the cinema back in the 80s. I 

love old sci-fi movies so I’ve decided to paint 

something with predominately cold colors, with 

just simple touches of warm ones. 

So, that is my palette and my mood for this 

illustration defined. Now onto the second render 

before we start painting. 

Using 3D as a base 
for 2D Painting
Software Used: Google SketchUp and 

Photoshop

Introduction
In this workshop we’re going to be working on a 

speed painting using base geometry created in 

the free software, Google SketchUp – nothing 

too detailed, just a couple of boxes as buildings, 

and a simple robot creation (created using 

the Google SketchUp tutorial featured at the 

beginning, by Richard Tilbury, as a guide). 

  

SketchUp 
SketchUp Render One

We have two SketchUp renders to start working 

with. The first one is a base render with the 

edges turned on (Fig.01); this image will be 

perfect to use to check our perspective lines, 

buildings and robot shapes over the top of our 

painting later on. I can also use the little guy 

close to the robot’s leg, in this case, to help me 

http://www.2dartistmag.com
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own. It’s a great idea though to get out of your 

“art cave”, and go and take some photos of the 

buildings in your neighborhood for your very 

own personal references (Fig.04). 

The cold layer is going to be our shadow color. 

How do we do this? Well it’s quite simple: we 

set the layer blending mode to Overlay and slide 

the Opacity value to 62%. The shadows become 

blue with this blending mode, but the highlights 

remain white. 

Next, set the warm color layer to Darken mode, 

and set the opacity to 86%. The highlights 

should now be sepia, but we can still keep the 

cold shadows (Fig.03). 

Textures and Perspective

Now that we have our base color implemented, 

it’s time to add some detail. Have a look in your 

personal texture library for a couple of photos 

of buildings. I’ve chosen some free photos from 

CGTextures.com for this piece, because the 

day I started this tutorial there was a huge riot 

in the streets of Buenos Aires and I couldn’t 

take my camera out to grab any textures of my 

With these three images we are going to texture 

our background. Add each one of these images 

to a separate layer and set the layer blending 

mode for each one to Overlay. Play with the 

http://www.2dartistmag.com
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the base of our scene to work quietly on the 

mood, characters and fine detail. 

Illustrating the Mood

Now it’s time to start working with the mood of 

the painting. Paint in a couple of streetlights 

– nothing complicated, just a dark silhouette 

of a streetlamp. For this step you can pick the 

color you have in the background to paint your 

streetlight; I usually use this technique to keep 

the color gamma balanced without any strange 

colors coming in. 

Use references from sci-fi movies if you want 

to add a nice touch to the illustration. I’m using 

Opacity value to mix the buildings with the 

building textures with the original SketchUp 

render. When you switch the layer on with 

the edges shown on the SketchUp render 

(SketchUp Render One), the edges will help you 

to find the correct perspective. 

Use the Transform tool (Ctrl + T) to set the 

correct perspective of the photos; you will see 

how easy the background will become more and 

more a part of the final illustration at this stage. 

Once you’ve finished with the Transform tool 

you should have something similar to Fig.05. 

Remember that up until this stage, we’ve only 

laid down some textures over our SketchUp 

render, so we still have all the fun part left to 

work on: the painting! 

Do you see how our painting still keeps the base 

colors we applied before – the blue and sepia 

colors? That’s the idea of the first step: create 

the design of some lights featured in a classic 

movie, maybe one of the best sci-fi movies of all 

time – do you know which movie it is?

I add another layer for the light halo effect and 

set the blending mode of the layer to Color 

Dodge. Never set the Opacity to 100%, try to 

mix every layer with your background image!

To add a story to this image I’ve decided to paint 

with a paintbrush a couple of bullets holes in the 

walls, to show that a horrible crime must have 

happened there, or maybe even a gang war 

of some kind. So now we have a non-textured 

police robot, some bullets holes, and a nighttime 

street scene (Fig.06) – the perfect mood for our 

sci-fi image!

The Robot

Time to paint our robot now! With the Lasso 

Tool and the Elliptical Marquee Tool, we can 

start to add shapes to our robot design. Make a 

selection with these tools and paint with a soft 

brush (with the Pen Pressure set to Opacity) 

inside the shapes. This technique takes some 

practice to get right, but you’ll find it really useful 

for speed paintings or concept artwork. 

Use the base 3D model to check the perspective 

and the shape of the robot; as you can see I’m 

using the same background palette to keep 

picking those colors for the robot (Fig.07). 

http://www.2dartistmag.com
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policemen is showing his partner, the robot (as 

if it were a car), the DO NOT CROSS yellow 

police tape (Fig.10). 

With my rain brush I paint on another new layer 

a rain texture, just over the streetlights (Fig.11). 

And that’s all folks! Here is the final painting 

(Fig.12). 

Painting is easy if you know exactly what you 

want to achieve with it, so keep up the practice 

– do it every day (I know I do) – and stay tuned 

to 2DArtist for more tutorials in the future! 

The body of the robot is smoother than the 3D 

model, as I’ve decided to use curved shapes 

instead. I want to take my time with this bad 

boy, working it section by section until I’m happy 

with the outcome. I also send some layers to the 

trash can at this stage until I really nail the final 

design of my robot!  

I keep working on the body and start on the front 

leg. Remember: during this step I’m just using 

the Lasso Tool and Marquee Tools with a soft 

brush to paint inside the selections. The back 

leg is a copy of the front leg, only I “deform” the 

shape using the Transform tool until it snaps the 

correct position of the new leg. Once happy with 

the body and the legs, I’ll continue with the fine 

detail (Fig.08). 

Details

On a new layer now I add the POLICE text 

and the robot’s identification number, following 

the shape of the robot using the Warp Tool 

(Fig.09). This is one of the most useful tools in 

Photoshop!

The last step is to throw some life into the 

painting, so I’m going to paint some cops 

looking for clues in the crime scene; one of the 

http://www.2dartistmag.com


Carlos Cabrera
For more from this artist visit:

http://www.carloscabrera.com.ar

Or contact them at:

carloscabrera@gmail.com

• Free Brushes
• Free Base Image
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mailto:carloscabrera@gmail.com
http://www.2dartistmag.com/tutorial_resources/issue_046_oct_2009/tutorial01/tutorial01_freeresources.zip
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“The more you are 

willing to make hair 

brushes, the more 

natural the results 

should become, 
Since fur is such a 

massive and complex 

structure...”

• Free Brushes

An artist’s brushes have always been a vital part of any painter’s set of tools, and remain the 

single asset that links paint with canvas. As such, they are crucial to how we view and interpret 

an artwork, and they afford the artist with a means through which to convey an idea or feeling. 

This has always been true throughout the history of art, and is no less important within a digital 

context. Software such as Photoshop and Painter essentially combine and fuse paint, canvas 

and brushes into a single tool. However, within this complex set of “tools”, brushes retain certain 

autonomy with their own, distinct set of parameters and presets, offering artists the freedom to 

affect and vary the way paint is applied. This principle of customizing brushes forms the focus of 

this set of tutorials, and aims to show how individual artists exploit these techniques to achieve 

some interesting results!

http://www.2dartistmag.com/tutorial_resources/issue_046_oct_2009/tutorial02/tutorial02_freebrushes.zip
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Custom Brushes- 
People and Animal 
Brushes 
Software Used: Photoshop

Introduction
Beautiful paintings hide many hidden and 

surprising discoveries, which is why, no doubt, 

you will enjoy looking at them for a while, losing 

yourself inside their secrets. The more variety 

you have in the surface, lines and textures of 

your painting, and once you know how to control 

the nature of your brushwork, the images you 

create will be much richer, and will never be 

boring!

To illustrate the creation of some brushes for 

people and animals, I have painted a new 

image, titled “Pu’s Forest” for the animal section 

(Final.01), and my latest portrait piece, “Lady 

in Red”, will be used to demonstrate some 

brushes created for interesting effects on human 

characters (Final.02).

Animals
I’ve always loved pandas – both giant and the 

smaller red pandas – perhaps because of their 

gentle nature, their cuddly appearance, and 

their modest way of living. It would surely be 

wonderful to just eat your favorite food all day 

long, and sleep most of the time, right? But the 

fact is that pandas, like so many other animals 

today, are in danger of becoming just a cute 

memory and a symbol of the WWF, if things 

don’t change soon. We’re all family on this small 

planet after all, and it was this concern that 

encouraged me to paint this innocent life that 

lives among us.

In this first section of the tutorial I’m going to 

show you how I painted Pu’s Forest, and how I 

created certain custom brushes for this special 

artwork.

Painting Pu’s 
Forest-a 
Walkthrough
References

We’ll need to find a couple of references to 
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because I like the tree’s interesting form, with it 

giving room for sky and space. I desaturate the 

photo to keep balance between the contrast and 

tonal values (Fig.02).

Step Three: Masks

I want to create masks now to define the basic 

colors and lighting before rushing into the 

painting work. To achieve a genuine impression 

and to allow the viewer to really dive into the 

image, I need to define the source of light and 

set the tone of the shadows. This is easiest 

to do using Adjustment Masks, by lassoing 

the highlighted areas around the figure and 

adjusting the Curves. I modify the tonal values 

to get a light, but strong, yellow backlight, and 

greenish shades (Fig.03a – b).

make a good start – just a few photos from 

the internet should be enough to get a good 

understanding of how fur works, with pandas in 

this case.

Step One: Sketch 

We want to sketch the animal in roughly – I’m 

using the Paintbrush Tool Texture Comb, in 

Photoshop. With a 15 pixel brush, Spacing at 0 

per cent, Other Dynamics turned on, and Pen 

Pressure at 0 per cent, I sketch in the figure, 

keeping the main reference photo close by 

(Fig.01).

Note: Paintbrush Tool Texture Comb is a CS2-

default brush in the Wet Media Brushes set 

(available in Photoshop CS, CS2, CS3, and 

Photoshop Elements 3+).

Step Two: Background

I choose my background early on. It’s good to 

pick up a background that will compliment the 

main figure and not overpower it, and in this 

case I select a personal photo from my library 
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Step Four: Custom Brushes! 

It’s now time to start playing with some big 

brushes. The first fur brush I want to create to 

aid this painting will not be a very subtle one, 

but will be made to fill the blank areas of the 

panda’s coat and give the feeling that it’s a living 

three-dimensional creature, rather than simply a 

flat impression of a panda. 

So to make this brush I go to File > New, set the 

size of the new canvas to 500 by 500 pixels, at 

300 pixels/inch, and select Transparent from 

the Background Contents menu. I then paint 

wide and thin brushstrokes across the canvas, 

using basic round brushes with Other Dynamics 

turned on. I erase some of the brush marks 

between the lines, and when happy I go to Edit 

> Define Brush Preset, and name the brush 

(Fig.04a). 

I can now use this brush to paint fur, with 

increased Spacing to at least 50 per cent, and 

Shape Dynamics on and set to Pen Pressure. 

Keeping the brush’s Opacity less than 40 per 

cent, the result remains translucent and is 

wonderful for painting animal fur. 

I decide to add the Paintbrush Tool Texture 

Comb to my newly created fur custom brush, to 

which I apply plenty of Scatter and Angle Jitter, 

and I achieve a nice varied result which can 

then be used to give texture to my foreground 

painting (Fig.04b – c).

Step Five: Using Painter

I sometimes find Painter useful to assist with 

my paintings. To soften the base hair and to add 

more “fluffiness” to it, I find it interesting to open 

up Painter and lightly use the Fine Feathering 

Brush (Oils) for the fur (Fig.05a – b). This stage 

is of course optional.

Step Six: More Custom Brushes!

The more you are willing to make hair brushes, 

the more natural the results should become, 

since fur is such a massive and complex 

structure as a whole, and so there is no such 

thing as simplicity involved here. 
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For this next brush I begin with the starting 

canvas as shown in Fig.06a. Using a canvas 

size as large as 550 pixels, I build up some 

varied brushstrokes using a Paintbrush titled, 

“Ornament 6”. I have no Other Dynamics or 

Spacing turned on, I just paint, making long, 

clear brushstrokes over the canvas, and once 

finished I simply save by defining the new brush 

preset.  

The next hair brush I want to make is 300 by 

300 pixels in size, and it’s made using the 

vector Pen Tool in Freeform mode (with Pen 

Pressure) with the Ornament 3 brush, Spacing 

at 25 per cent. This particular brush is excellent 

at showing hair which is close-up, for example 

on the face area and around clear edges. Whilst 

painting with this new brush, it’s convenient to 

use the Pen Tilt setting, to make sure the hair 

flows in the right direction as you paint (Fig.06b 

– c).

Note: The Ornament 3 brush is a default 

brush in the Assorted Brushes set in CS2. The 

Ornament brushes are simply default brushes, 

and the Pen Tool is used to make the actual 

strokes; for example, you draw the free lines 

with the Pen Tool and then right-click over 

them – I use the Stroke Path with this particular 

Ornament 3 brush.

Note: The Pen Tool is quite uncommon, but 

it’s a really awesome tool and serves great 

with quick illustrations! I use it in my artworks 

because it gives a clear line and form shapes, 

and it’s quick and easy to adjust later on. To 

make brushes it also serves well since it doesn’t 

leave any fuzziness or “mushiness” to it, and 

the result stays sharp. Play around with it for 

yourself, if you’re new to the Pen Tool!

Step Seven: Feather Brushes!

With the image progressing things are getting 

more and more subtle, so as we paint we’ll find 

that we need to decrease our brushes in size. 
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The next two brushes I’m going to walk you 

through are 150 pixels each in size. The first 

one is the simpler one, made with just a few 

strong strokes from one corner of the canvas, 

spreading them out like a fan whilst preventing 

the lines from touching one another to keep the 

result “airy” (Fig.07a). This brush is nice to use 

for details, and to add even more dimension 

to surfaces. It’s a great one for both fur and 

feathers, and it’s all about mixing a few good 

brushes together, not just sticking with one for 

too long.

The other brush suitable for feathers/fur is 

shown in Fig.07b. This one is constructed with 

the Freeform Pen Tool again, with Pen Pressure 

on, and I basically warp the ends to be more 

rounded, making a bundle with curving edges. 

By adding a few transparent gradients to the 

ends and erasing a few parts of it away, there’s 

a nice transparency involved, so when painting, 

the strokes can easily blend in with the layer. 

I use this brush for the little bird in the 

foreground, mostly painting it with small tip using 

various Normal/Overlay/Screen/Color Dodge 

modes. By changing the Spacing and Shape 

Dynamics, this brush also works just as great for 

both small details and for texturing larger areas 

(Fig.07c).

Step Eight: Detail Brush!

I want to refine the image now, and as part of 

this process I’m going to make a special brush 

for the details. With the painting coming close 

to the finish line, I find it necessary to make a 

single-haired brush to bring out the sunlight and 

highlight some of the hairs. 

I must point out that throughout the painting 

process there have been plenty of soft 

translucent gradients used in Screen and 

Multiple modes, and for all the shades and color 

variations I have been using masks. So building 

this scene is not just about brushwork, but about 
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point, the whole image is flattened and you 

can look it from a distance and make your 

finishing moves. Working freehand, make a few 

distinctive lines to areas that emphasize the fur 

and form of the animal. Add the brushstroke to 

the Pen Tool, and transform the path by warping 

it. Repeat this, changing the Stroke to Screen 

Mode and Linear Dodge mode; with dark hair 

switching between methods to bring life to this 

adorable panda cub.

So back to the brush, this single-haired custom 

brush I’m going to make on a 250 pixel canvas, 

so there’s room to make it much smaller or 

bigger, as I need to. With long, slim strokes, 

and warping the lines by compressing them all 

together, the result is slightly rough and natural 

(Fig.08a). 

I use this brush for the areas on panda’s side, 

cheeks, nose, and on top of his head – around 

the ears, in particular (Fig.08b).

Step Nine: Touch-Ups

I need to make some final touch-ups now with 

the Pen Tool, and finish the surface texturing. 

For great final results you need to take the Pen 

Tool and a very slim brush – Hard Elliptical at 

around 5-8 pixels works fine for this. At this 

use Multiply mode instead. Remember to erase 

the sharp tips away very gently. Repeat this until 

there are distinctive hairs showing clearly. The 

whiskers are painted in a similar way, using a 

light beige tone with the brush in Screen mode.

Note: For those who are less familiar with the 

Pen Tool, what we are doing is adding strokes to 

the Pen’s path lines by using Screen and Linear 

Dodge modes as you make the Stroke (right-

click > Stroke Path). Once this is done, you can 

delete the Path and use the Free Transform’s 

Warp-tool to reshape the form of the brush.

With all the elements in place I can finally add 

some highlights with a canvas texture to give 

a nice traditional feel to the surface, so it looks 

alive and bright. Sharpening the work is the last 

thing I do, but of course I’m careful not to overdo 

it.

People
In this second section of the tutorial we’re 

moving on to people, away from those adorable 

animals. I’ve chosen my latest portrait, Lady 

in Red, to show the use of custom brushes for 

this genre, because it is a good contradiction 

between the subjects and styles of this tutorial, 

as well a nice comparison to illustrate overall 

how different brushes serve different kinds of 

purposes with regards to painting themes. I’m 

not going to go through the painting process 

of this piece, as I did with Pu’s Forest, but I 

will instead give some examples of how this 
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piece was so fun to create by simple means – 

meaning custom brushes, of course.

Skin Brush

This skin brush is the speckled type, which is 

good for showing characteristics, the roughness 

of a surface, as well as portraying glitter and 

pores. You can make these characteristics as 

detailed as you wish with this brush.  The brush 

itself was made using the Freeform Pen Tool, 

used in the piece with Spacing at 30 per cent, 

some Angle jitter, and Other Dynamics turned 

on with Pen Pressure (Fig.9a – b).

Mixed Brush

To make a variable “unrefined” skin texture, 

this brush is made by adding several default 

symbols and shapes together from Photoshop’s 

Shapes library. You simply draw a few original 

lines with the Pen Tool in Freehand mode, and 

then add the shapes and symbols to the paths. 

When happy, just save it as a new brush preset 

(Fig.10a). 

This brush is also great for adding elegant 

details such as around the head area and give 

airy and flow to the work – best when it’s used 

with plenty of Spacing and Shape/Angle Jitter. 
You might not believe this brush to work for skin types at first, but once 

you modify it, then you see how fun it can be to use for many different 

purposes (Fig.10b).

Fuzzy/Clean Hair Brush

This is easy to create: just use the same Freeform Pen to make different 

smooth twirls and wavy lines across the canvas (in this case 400 by 400 

pixels in size), fill the lines with black, and then save the result as new 

brush preset (Fig.11a). Now, by altering the Shape Dynamics, Spacing, 
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and Other Dynamics, you can make a really 

interesting hair type using this brush (Fig.11b).

Another Skin Brush

For this other skin brush, I simply take a public 

photograph from the internet with an example 

of straw. I click on part of it with the Lasso Tool, 

and take the selection for the basis of a new 

brush, using a canvas of 300 by 300 pixels. I 

use this skin texture for the hand, and for the 

arm’s skin to make it look pretty disgusting – dry 

and fallen off, like she’s a zombie of some sort 

(Fig.12a – b). 

OK, well that’s about it from me! I hope all 

of these examples have been useful and 

interesting, and that you’ve enjoyed reading this 

tutorial. I hope you have many great moments 

with your own paintings – enjoy it!

Kirsi Salonen
For more from this artist visit

http://www.kirsisalonen.com/

or contact

salonen.kirsi@gmail.com

http://www.2dartistmag.com
http://www.kirsisalonen.com
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This series of tutorials aims to show some of the methods and processes used to design and develop characters 

from initial thumbnail sketches through to a final concept. The series will be divided into five parts and will focus on 

the general design methods commonly used by character artists. It will begin with quick sketching techniques used to 

suggest ideas and develop a theme before moving onto creating variations once a subject is established. The third 

instalment will culminate in a finished concept design, after which we will move onto the importance of posing your 

character and the impact this has on their personality. The series will conclude with a chapter dedicated to choosing 

suitable eye levels and camera views to best convey an emotional state or emphasise a storyline.

Chapter 1 | Thumbs & Silhouettes

Chapter 2 | Visual Brainstorming – Variations on a Theme

Chapter 3 | Speed Painting & Concept Design

Chapter 4 | Dynamic And Exaggerated Poses 

Chapter four will move onto the topic of posing characters and the importance this has in 

relation to personality and adding a dynamic to your designs. Choosing a suitable posture 

and using exaggeration can make all the difference and this is where we gain an insight into 

the importance of such topics when trying to describe a characters inner nature. 

Chapter 5 | Camera Placement, Framing, Fore-shortening & Distortion

“...this process of gesture drawing 
is cross-platform - from animation, 

illustration, film design, 
storyboarding, concept design, 
visual development, character 

design and everything in-between. 
It’s the root of all things. It’s the 

first step and the last adjustment 
to any amazing illustration...“…

Author of The Art and Feel of Making It Real: 

Gesture Drawing for the Animation and 

Entertainment Industry, and with a client list 

including Walt Disney, Pixar, Sony as well 

as many other impressive companies, Mark 

McDonnell takes time out from his design work 

to teach us a thing or two about dynamic and 

exaggerated poses for our character concepts 

… As well as a little something about the 

importance of growing a beard!
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Part 4: Dynamic And 
Exaggerated Poses

Introduction
To create a dynamic and exaggerated pose 

is to push the limits of human (or animal) 

physics. This becomes much easier if one has 

an understanding of the anatomical make-up 

of the human body. Many artists have spent 

lifetimes figuring out the mechanics and how 

the “human machine” performs under various 

stresses. It can take a lifetime to perfect the 

mechanics of the body’s movements and 

gain the understanding of how all the pieces 

fit together to form the perfect puzzle. For 

the sake of using this information to help you 

perform in the animation and entertainment 

industry, simplifying is just as important as 

understanding the complexities of the human 

(or animal) form.

In figure drawing, this is an incredible practice 

that must remain in one’s studies until we 

have all grown the long white beard worn by 

those giants that have come before us (ladies, 

please excuse the beard reference). Giants 

such as Michelangelo, Rembrandt, Raphael, 

Parmigianino and countless others, all spent 

a lifetime accumulating the knowledge of the 

human body to plaster images on high ceilings, 

religious institutions and various cultural meeting 

spots.

These images are various studies I have drawn 

recently (Fig.01 – 03). In the following images, 

however, you’ll see more of a purpose than in 

these initial ones. 

That purpose is simply: the story. 

Story
The story should always be in your head when 

you are after anything that deals with gesture 

drawing for any medium or platform you are 

designing for. Imagining what the person, 
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under the foot of the victor, yet it may appear 

dead or somewhat soulless. This is generally 

due to a lack of dynamic and exaggerated 

posing.

Standing Poses
Let’s start with an example of a person standing 

at the bus stop waiting for the bus to come and 

pick them up to carry them to their destination. 

Pulling out the trusty sketchbook and observing 

life is just as important as sharpening a needle-

sharp pencil to do figure drawing or holding a 

stylus ready to begin an illustration!

    

Please note: I am an artist who primarily works 

in the animation industry and my personal 

preference is in finding character and pushing 

the pose to support the action and personality 

that a particular individual would exhibit.

In the first example, perhaps an elderly man is 

waiting by the bus stop, happily content to get 

to his next destination. As a character designer 

and visual development artist, one is always 

character or beast is thinking will make 

your work transcend the typical study we 

happen upon on various portfolios, blogs 

or websites as we scour the Internet for 

sources of inspiration.    

As you can see in these quick sketches 

(Fig.04), there is a thought behind the 

sketches, not just an application of how 

light falls upon the form. Perhaps thinking 

in terms of feeling ill, worriedly on the 

lookout, or yelling something specific 

will determine a better understanding of 

not just the pose but the story of what’s 

happening for this particular pose. 

This type of thinking is the first step in 

creating a dynamic and story-driven 

“interpretation” of how to approach 

sketches that will lead to final rendered 

pieces. Without this first step you may 

have a beautiful, well-rendered piece 

full of incredible and dramatic lighting 

that suggests the ultimate battlefield, 

strewn with the bodies of warriors placed 
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concerned not only about the personality, but 

the overall shape a person has, and how that 

shape will read from a great distance. This is 

something to always consider when sketching. 

There will be hits and misses, but always think 

about the overall silhouette and if and how that 

pose reads to clearly describe who that person 

is, or what their specific action is. The clearer 

the better! This is why exaggerating the pose 

is so important and necessary in the animation 

and entertainment industry. 

Sometimes – as with this example of the elderly 

man (Fig.05) – subtleties are more important 

than a bold action. Knowing when to use what 

is just as important as the actual drawing itself. 

In the elderly man you can see he is slightly 

off kilter and not as sure footed as some of the 

other characters waiting at the bus stop in this 

next illustration (Fig.06). Generally speaking, 

the wider the feet are from the center of the 

body, the sturdier the posture will be due to a 

greater balance of weight from the center point 

of the body.

In pose B, we can see the character is leaning 

in to see around the corner for the bus that she 

is so eagerly waiting for. She also is holding her 

hands behind her back, showing even more of 

an uncomfortable wait that may cause her to be 

late for an important function.

In pose C we can see the woman is slightly 

more aggressive just from her stance. Her 

posture suggests more of someone “on guard” – 

her legs are more apart, increasing her center of 

gravity, giving her a stronger stance.  

In pose D we can see this lady is slightly more 

withdrawn and kept to herself. We can see that 

by the way she’s enclosed her hands and is 

crossing her arms. She’s balanced in her stance 

but ready to move quickly, if need be.

In poses E and F we can see these two are a 

couple straight out of a Hollywood roadside. 

Their close proximity suggests they are together. 

It also shows by their general look. She’s 

strongly stanched to look good, while he’s more 

in command and ready for anything that comes 

his way in an effort to protect her, based upon 

his widened stance, similar to pose C.

In the following illustration examples, we’ll be 

approaching more movement-based drawings.

Movement
By taking the same knowledge from the 

sketchbook drawings and applying it to life 

drawings, the sketches will appear much clearer 

and grasp more of the “spark of life” others are 

so drawn to, such as the examples (Fig.07). 

Certain situations call for more dynamic, 

“pushed” poses, while other poses demand a 

more subtle style of dynamics. For example, 

the sketchbook pages of the patrons waiting 

to be picked up from the bus stop show these 

subtleties. A more dramatic, or a subtle push, 

can both be accomplished by focusing on 

the overall silhouette. This will automatically 

exaggerate the pose and make it far more 

dynamic than merely copying what you are 

seeing in front of you. From here, adding the 

subtleties of what the character or person is 

thinking will generally push the drawing over the 

edge and into the “unique” category.  

But always remember: be it figure drawing, 

character design, concept design, film design 
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or anything in-between, the root of it all is 

capturing the correct amount of “life” that will be 

appropriate to the particular project that is being 

worked on. This is why figure drawing is such 

an amazing and unending source of inspiration. 

It’s unending because you will be practicing 

whatever you are interested in experimenting 

with directly into the challenge of figure drawing 

itself. 

One good rule to always follow is to leave 

the facial features or expressions last. It’s my 

personal feeling that the entire body language 

without the face should communicate what 

the action is in the pose, or poses. It’s really 

the icing on the cake and can be the greatest 

exclamation mark at the end of a statement. 

Take a look at some of the sketches here to see 

some gestural approaches to feeling out the 

pose, and more importantly, the character that is 

posing (Fig.08). 

From the ballerina sketches to here, you can 

see that pushing the pose into a more dynamic 

and exaggerated way will increase the 

storytelling aspect of a drawing or concept, 

as well as give you that “spark of life” you 

are searching for in any piece of artwork. 

With that being said, this process of 

gesture drawing is cross-platform – 

from animation, illustration, film design, 

storyboarding, concept design, visual 

development, character design and 

everything in-between. It’s the root of 

all things. It’s the first step and the last 

adjustment to any amazing illustration and 

should not be overlooked in an effort to 

finish a piece for production purposes or 

otherwise (Fig.09 – 10).

Note from the Editor:

Mark McDonnell recently published the book 

entitled, The Art and Feel of Making It Real: 

Gesture Drawing for the Animation and 

Entertainment Industry. It is a comprehensive 

and complete guide to gesture drawing that 

explains how to design and capture 

the essence of life, giving anyone from 

hobbyist to industry professional the tools to fuel 

the power of their imagination for production 

purposes or otherwise.

Mark McDonnell
To purchase Mark McDonnell’s book or view his 

artwork please go to:

http://www.cre8tivemarks.com (Store section)

http://markmcdonnell.blogspot.com/

or contact

cre8tivemark@aol.com
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“I cannot stress enough how 
important it is for any painter 

to learn to see colors, and 
learn to know what happens 

when you mix them.”
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Chapter 4 - 
Colouring from 
Greyscale, Colours 
beyond Blocking-In, 
Blending Methods 
and Using Photos
Software Used: Photoshop

Introduction
This month, let’s take a small U-turn and look 

at another way of starting a painting, as well 

as at how to color a scanned drawing. We 

will get back on track afterwards, and 

continue where we left off, checking out 

how to really work with colors and make 

colors work for you, different blending 

methods, adding things to your painting 

and changing them around if necessary, 

and using photos directly in your painting 

(as often done in matte painting).

From Idea to 
Reality
Color theory, as we saw, can be a 

very complex, especially when you’ve 

not quite got the hang of it and colors 

still seem like aliens to you; aliens 

that torture and frustrate you because 

they simply don’t want to work together, 

no matter what you try. And there goes the 

painting – a perfectly good one – right out of 

the window. If only there was a way to do it in 

a monochromatic color scheme (which most 

people find easier to work with as it keeps 

things quite literally black and white) and 

then make the colors magically appear…

Well, there is!

Painting in 
Grayscale
Let’s assume you’re really good at shading 

in black and white (like with charcoal or 

graphite), and would prefer to start your 

paintings like that because it’s easier for you 

and lets you concentrate purely on what you’re 

painting or drawing, rather than having to keep 

color theory in mind at the same time. You would 

do exactly that, using the same brushes and 

methods we discussed in the last issue, only 

you’d do it all in black and white.

Note: You can open a new canvas in Grayscale 

mode, and you can also change your canvas’s 

mode once open from RGB to Grayscale by 

going to Edit > Mode > Grayscale. This setting 

is not needed to draw or paint in black and 

white; it reduces the file size. You can of course 

switch your canvas to Grayscale Mode if you 

like – this can be reversed at any time in Edit > 

Mode, but if you intend to color your painting, I’d 

recommend leaving it as it is on RGB from the 

start.

Let’s have a look at what we’ve got (Fig.01). 

This is simply a desaturated version of the 

painting we started in the last chapter. To 

desaturate a color picture (for whatever reason), 

just go to Image > Adjustments > Desaturate. 

After doing that, you may have to adjust the 

Levels slightly, as certain color combinations 

give you a very dull and muddy grey, washed-

out appearance.

The painting is of course still in its early stages, 

but it will get the point across. In essence, 

you can finish a painting to the tiniest detail in 

grayscale, and then do what I’m about to show 

you…

There are in fact several methods to coloring a 

black and white image; however, I’ve found this 

one to be the most adjustable and thus usable 

one:

Once you’ve selected your Paintbrush, change 

the Mode of your brush – you can do that in the 

options bar, next to the manual Opacity and 

Flow settings (Fig.02). The modes that I would 
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suggest are Color (gives you the most true-to-

reality color – great for the first layer), Multiply 

(makes colors darker), Overlay (makes dark 

colors darker and light ones lighter, while also 

making them more intense), and Screen (makes 

colors very bright).

This only works if you do not add additional 

layers to your painting, but paint the color 

directly onto your existing layers. If you want 

to add a new layer to your painting for this, 

you need to set the new layer’s mode to Color, 

rather than the brush’s! If you already have 

several layers in your image, add a new layer 

on top of each one of those layers if you want 

to keep the layers intact. Simply select a layer, 

and then add a new one. It will automatically be 

added on top of the selected layer (Fig.02a).

Working with layers here makes it a little more 

complicated, but might be useful if you think 

you’d rather play it safe.

So you’ve got your brush – a biggish, Hard 

Round one would be good, you’ve got your 

Brush Mode set to Color, and you’ve added your 

new layer(s). Now choose your colors and paint. 

If you’re using layers, make sure to keep them 

separate, as in, don’t paint the blue of the sky 

on the layer that was added on top of the arch, 

for example (Fig.03).

If you’re using layers for the coloring, 

be careful not to draw over things 

we want to color on a different layer. 

In essence, this is a bit like a grown-

up coloring book exercise: don’t go over 

the lines! This is easier when not using extra 

layers, as you can apply the Lock Transparent 

Pixels function in your Layers Palette for your 

layers (like the arch).

Because of the monochrome painting shining 

through the color layers, there is no need to 

really think about shadows and highlights at 

this point. To add some darker or lighter color 

variations, simply switch your Brush Mode 
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if you want to, and generally do anything you’d 

normally do with any other digitally created layer 

(Fig.04c).

With this covered, let’s head back to where we 

left off last month.

and set it to Multiply in the dropdown menu. You 

should now be able to see through your drawing 

onto the background (Fig.04b).

Now you can paint beneath the scanned 

drawing without losing it, add layers beneath it 

to Multiply, Overlay or Screen, and continue 

painting, lowering the Opacity of your brush at 

your leisure. This, again, doesn’t work when 

using extra layers and you’ll have to add even 

more layers with their modes set to Multiply, 

Overlay or Screen (Fig.03a). 

If you’re not happy with the overall color 

variations, highlights and shadows that you 

can achieve with this method, you can just add 

another layer right on top of all your other layers, 

switch the Brush Mode to Normal, and paint 

over the areas you want to adjust (Fig.03b). You 

can also merge each of the grayscale layers 

with its color counterpart, and then continue 

painting in color in Normal Mode (with or without 

additional layers).

This same method can be used with color 

scanned drawings, especially if you would like to 

keep the line art. You can also do the following 

with scanned drawings – and this is great if you 

want to just use the drawing as a sketch that 

won’t be seen in the final picture:

Duplicate the Background Layer by going 

to Layers > Duplicate Layer – you should 

now have two layers on your canvas: the 

Background layer and a layer called Background 

Copy (Fig.04). Now select the Background layer 

again, go to Select > All, and then go to Edit > 

Clear. This will clear the Background layer of the 

drawing and instead fill it with whatever color 

you have set as your background color 

(Fig.04a). Deselect the canvas (Select > 

Deselect). Next, select the Background 

Copy layer again in your Layers Palette, 
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Painting with Colors 
Believe me when I say that I hated painting with 

colors for quite some time. I just couldn’t make 

them work for me; couldn’t get things to look 

right; couldn’t get them to look real, radiant, 

iridescent ... Everything had about as much flair 

as a dull plastic tub!

In the first stages of your painting, that is OK. 

You want to lay down the basic colors, or 

even the colors that will be a good base to 

shine through the ones you later want to add. 

But at some point, you will have to add color 

variations, lest you want to end up with the 

aforementioned plastic tub look, which seems to 

be a common thing and is due to just choosing 

lighter and darker shades from the same hue 

– or worse even, black and white for shadows 

and highlights.

So, what’s the best way to address that? – Yes, 

you do need an eye for colors, and be it just an 

eye that can tell which two different blues work 

together, and which don’t. Without that, it will be 

very hard to learn working with colors, as you 

can only learn so much.

A good way to choose further colors for your 

painting is to pick the main colors off the 

painting and paint them in blobs or stripes on a 

new, small canvas. It works best if you have the 

colors going from light to dark, or dark to light 

(Fig.05). You may have done this already before 

you started your painting, and if you have, just 

open that little image of colors and see where 

we are going with this. 

In this case we have a limited color palette, 

which is a bit harder to get to look iridescent 

simply for the lack of “available” colors. Imagine 

it like having only a set number of paint tubs 

available; there is only so much you can do 

with them. The first thing you can do is mix the 

existing colors to get new hues and shades. Try 

this by using your Paintbrush and at low Opacity 

paint with one color over the others (Fig.05a). 

You may have noticed this effect when you 

were blocking in your painting – make use of it 

and use the colors that appear by picking them 

off the canvas. You can also add some similar 

hues into the mix, broadening the palette while 

still retaining a limited one (Fig.05b). You can 

do this with any color combination, and see if 

it works. For fun, you can also pick two 

random colors, and try and see if you 

can make them “link” by adding the 

needed colors in between the two. You 

can get some really wild but working 

color schemes that way. 

As said before, if it helps you, use 

references for colors as well, like photos of 

sky and clouds, deserts and stone structures 

– whatever you need. Try to avoid picking the 

colors directly off the photos, though. Sure, it 

would be easy enough and spare you having 

to look for the right colors yourself, but if you 

do that, you’ll never learn to do it by yourself. 

Your eyes will never adjust to seeing colors for 

what they really are, and where they appear – 

often in the most unlikely places. Also, zoom 

in on a photograph on your computer to 300 or 

400%. You’ll see that what looked like skin color 

when zoomed out will suddenly be a myriad of 

different colored pixels – the different colors that 

make up the skin color in that small part of the 

photo. If you were to pick a color from the photo, 
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you’d pick one of the many, and later wonder 

why it still doesn’t look quite right, and often still 

very flat.

I cannot stress enough how important it is for 

any painter to learn to see colors, and learn 

to know what happens when you mix them. 

Of course, this is a much more vital part in 

traditional art than it is in digital, but still saves 

you a lot of trial and error when painting on the 

computer. It may take some time, but it’s worth 

it. Promise! Just think about it: how great would 

it be to be able to just paint something, without 

having to look at references or using help to 

choose your colors?

So let’s get back to the painting once again, 

and continue refining it, adding more colors and 

cleaning up some of the mess we’ve made. 

I personally like to mainly stick to the round 

Paintbrush at this stage still, occasionally 

using some custom brushes to achieve a good 

amount of texture foundation, with lowered 

Opacity, as well as having the brush’s Opacity 

Jitter set to Pen Pressure. I just like the wash 

effect I can achieve with these settings, 

layering the colors and giving the whole image 

a more translucent look. If this is not for you, 

and you prefer solid colors, go ahead! That’s 

great, too.

In both cases, you may want to learn how to 

blend the colors without making them all muddy 

and having your shapes lose form – something 

that easily happens if you blend too vigorously; 

things become blurry and undefined.

You can either blend with your brush as 

previously shown, simply by lowering the 

Opacity sufficiently, and maybe even making 

the brush a little bit softer. Not too soft though, 

as otherwise you’d again end up with blurred 

mud. You can also change your Brush Tip to 

a textured brush, or a speckled one, to avoid 

making it too smooth. Also, rather than just 

blending with the two colors you want to blend, 

pick some shades from the canvas that have 

already been blended – it will give you a better 

transition (Fig.06).

Another way to blend would be to use the 

Smudge Tool, which you can find under the 

Blur Tool (Fig.07). Now, this tool has a very bad 

reputation – I personally hate it with a passion 

when it’s overused, and overused it is more 

often than not – but it can do some good, too. 

When used with the wrong (or should I say 

“default”?) settings, it simply pushes the paint 

around on the canvas, creating something akin 

to a smudgy batik effect (Fig.07a). Sure, there 

are some things this is good for, like certain 

types of clouds, but to make it blend colors 

properly, we need to change the settings as well 

as the Brush Tip it uses. I like to use a speckled 

tip, or otherwise textured and ragged. Next, I 

apply the following Brush Settings: 

The Shape Dynamics are manually set to Angle 

Jitter with the slider, while all other Shape 

Dynamics options are off. Scattering is also 

manually adjusted – to as little or much as I 

want or need to get a certain result, so play 

around with this – and Other Dynamics is set 

to Pen Pressure. These settings give you a 

result that is much more appealing, while at the 

same time adding some texture to your work 

(Fig.07b).
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To show some of the process, here are two 

screen recordings I made while working on the 

next stage of the painting. They show roughly 40 

minutes of work each, shown at 6x their original 

speed, as this shows the progress much better 

and also clamps down on file size (Movie.01 – 

02).

Reviewing and Making 
Adjustments
After some hours of work, we’re ready to review 

what we’ve done, in a manner of speaking 

(Fig.08). First of all, I want to adjust the Levels 

of the painting, as I realize the colors don’t quite 

have the impact I want them to have. Yet! You 

don’t have to do this now, or at all, or can do it 

whenever you like – the choice is yours. 

At this point, it may be a good idea to flip the 

canvas horizontally, to give you a fresh view 

on things. This is most important for portraits 

or general figure paintings, but also helpful for 

landscapes and cityscapes, too. It can show 

you where your elements may need some 

adjustment. As for the composition, this usually 

works just one way, not the other, as more often 

than not a composition was put together in a 

specific way to draw the viewer’s eye to certain 

elements within the painting. Therefore, when 

flipped, the composition is best left alone. To flip 

(mirror) the canvas, simply go to Image > Rotate 

Canvas > Flip Canvas Horizontal; depending on 

your computer and image size, this may take a 

moment. 

I decide to resize the arch to make it a bit 

bigger. I do this by selecting the layer it’s on, 

and then go to Edit > Free Transform. This will 

make a box appear around the arch, much 

like the box we know from the Cropping Tool 

(Fig.08a). To keep the aspect ratio of your 

arch – meaning that it will resize all sides the 

same way – you need to click the little Link icon 

between the Height and Width in your options 

bar (Fig.08b). Now you can either click inside 
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the Height or Width field and enter a percentage 

manually, or use your arrow keys to up or down 

the percentage (Fig.08c). Or, simply click the 

corners of the box and pull or push them to the 

desired size (Fig.08d). 

You can also push and pull on the sides, but 

this messes with the aspect ratio of the item to 

be resized. You can also rotate the selection 

by clicking outside of the corners and turning 

the box – just like with the Crop Tool. Here you 

can also adjust the perspective of objects, in 

case you need to. So it’s handy to have the 

perspective grid layer visible while doing this. 

You can switch between different Transform 

Modes while transforming (just go into Edit 

> Transform to do that). Once you’re happy 

with what you’ve got, click the tick mark in the 

options bar, or double-click outside your canvas 

to apply the transformation.

Flip the canvas back to its original state. 

If you do something like this to an object 

that casts shadows, those shadows will 

have to be adjusted accordingly. In my 

case, the shadows of the arch are painted 

on the background, which means I either 

need to re-paint them, or simply transform 

them, too. To do this, I select them (well, 

one at a time) with the Lasso Tool (Fig.08e) 

by drawing a nice big circle around them 

– you don’t just want to select the shadows 

themselves, but some of the sand as well. Then 

we go to Edit > Copy, or simply press Ctrl + C, 

to copy the selection. Then we paste it by either 

going to Edit > Paste, or by pressing Ctrl + V. 

This will paste the selection in the same spot 

you selected it from. Now you can move and 

transform it the same way as any layer. 

Sometimes the perspective needs to be 

changed, and this can be done with either Edit 

> Transform > Perspective, or Edit > Transform 

> Skew. Afterwards, erase the hard edges that 

may be visible of the selection to blend it with 

the rest, and if necessary paint a little over them 

where it doesn’t quite work. Now go into your 

Layers Palette and merge the selections with 

the Background Layer (or whatever layer they 

should be merged with). 

Looking at it a bit longer (in fact stepping away 

from it for a night), I feel that the whole picture is 

too open. Sure, it works, but not for what I have 

in mind. Too much sky, not enough looming 

rock faces. So I add to them by simply painting 

over the background. The sky itself needs to 

be darker, too, and so I paint over that, as well. 

After an hour of adjustment, we have what you 

see in Fig.08f.
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Note: By the way, if you are getting tired of 

zooming in and out all the time, especially when 

working on a small area to see what it looks 

like as a whole, you can try this little trick: Go 

to Window > Arrange > New Window for… 

It will open your painting a second time in a 

new window – this is not a copy, but a clone. If 

you paint on one, the same brushstrokes will 

simultaneously appear on the other. Closing one 

closes the other. So be careful! In any case, you 

can zoom out of one of your painting windows 

now, while zooming in on the one you’re working 

on, and see what effect your efforts have on the 

one you zoomed out. It’s pretty cool!

Now, landscapes are nice to look at, but in 

this one, you may have already noticed that 

something is definitely missing; something to 

grab your attention and make you want to look 

at it more closely. 

As mentioned at some point in the last 

workshop, I consciously laid out the landscape 

like this, as I have plans, namely to add a figure 

into the painting. And if you remember the 

overlaid Fibonacci Spiral, you will already know 

where I want the figure to be, and there really 

is no other place to put one but sitting on top of 

the arch.

Adding a Character
So, let’s add another layer to the painting to 

sketch the figure. I want it to be a girl, mainly 

because girls get away with wearing dresses – 

long flowing dresses at that – which is exactly 

what I want. If you need references for this, feel 

free to use them. I had my husband take some 

photos of me to help me with the pose, as I 

generally like to have a point of reference for 

poses I’ve not drawn before (foreshortening and 

perspective can be a real pain when it comes 

to people). Please forgive me for not showing 

the photos, I’d just like to retain a little bit of 

dignity…

In any case, just as before, we’ll grab the round 

Paintbrush and sketch the figure on the new 

layer (Fig.09). I’ve changed the sketch to white 

simply for the benefit of seeing it better here, 

but I will have it in black once I start working on 

the colors. You can see I let the dress trail 

around the arch and off into the distance, 

which will help draw the viewer’s eye 

from the figure and arch into the distance, 

to take in the entire scene. It is not 

necessary to do this, as other elements (or 

a different composition) can achieve the 

same thing.

To paint the girl, we add more layers beneath 

the sketch layer – one beneath the arch 

layer for the girl and the parts of the dress that 

are behind the arch, and another one above 

the arch layer for the dress tendrils – and 

proceed as we did before with the Hard Round 

Paintbrush to block in the first few colors.

Here, again, you can choose your color palette 

before starting to paint. At the first try, I had 

given her a red/orange/pink dress, because 

usually this pops the color scheme quite nicely, 

but in this case it was too much, too distracting, 
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and I went with white instead. Now, white is one 

of those colors – even though it strictly speaking 

is not a color – that can be hard to get right. 

Using pure white never works other than for 

gleaming, punctuated highlights, and even then 

has to be used with care. To get a white that 

works well, mix in some surrounding colors of 

the painting, which in this case is browns and 

ochre greens, and some blues as well. Her skin 

tone will mainly be different shades of browns, 

with some yellow and possibly purple thrown in 

for good measure (Movie.03).

Something you may want to bear in mind when 

painting people – or objects with a curved 

surface – is to adjust your brushstrokes to those 

curves. Rather than making straight strokes, 

try and follow the curve of an arm or jaw line or 

fabric fold. It will instantly add form to it.

Reviewing the 
Painting Once More
We are at a stage now where we can once 

again review the painting. To get to this stage 

may take you anything from several hours to 

several days, depending on your practice. 

And it takes just that: practice. If you feel 

annoyed that you can only work at a slow 

speed, keep at it, practice, and you will get 

faster the more intuitive the work becomes. 

Just don’t give up. If you feel yourself 

getting tired of working on the same 

painting for days or even weeks, maybe 

start another one, and when you get tired of 

that, go back to the one you were working on 

previously. Find ways to make it interesting, 

but try and finish your work, as only then you 

can properly see how much you’ve learned from 

one painting to the next. Besides, it feels great 

to look at a finished painting and be able to say, 

“I did that!”

While looking the painting over, I still feel 

something isn’t quite right yet, and after 

stepping away from it for a few hours (always 

a good thing to do when you feel stuck – go 

grab a coffee with a friend, or cook or clean) I 

realize that it’s still the colors that seem a tad 

too cheerful for my taste, or rather, the purpose 

of the painting. So I adjust them once more, and 

also adjust the crop of the scene, which gives 

me what you see in Fig.10.

Note: For details and small things in paintings, 

using the round Paintbrush with Size Jitter, as 

well as Opacity Jitter switched to Pen Pressure, 

is very handy. Sufficiently reducing the Opacity 

and Flow manually is also helpful, as it will save 

you blending too much with the Smudge Tool. 

I like seeing the texture of brushstrokes, as 

this gives a painting personality, and with it, a 

distinct style. Your style!

The “Yucky Stage”
We are far from finished, but this shouldn’t 

deter us. The point the painting is at right now 

I call the “yucky stage”. Everything is there and 

discernable, but looks kind of crappy. I greatly 

dislike that stage, because it is so easy to just 
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give up here and say that it’s not worth it. It’s 

frustrating and annoying. You had this great 

vision in your head, but what you’ve done so 

far simply doesn’t match up. 

Well, as said, we’re not done yet. It’s cool 

to change things as you go along, and 

it’s also great to stick to what you’ve 

started with. Sometimes paintings need 

to develop as they are being worked on 

– and that appears to be the case here. 

I certainly didn’t plan to make that many 

overhauls, especially not for a workshop, 

seeing that it can be a bit confusing. Alas, 

here we are. Maybe it’s not all that bad 

after all, as it shows how versatile Photoshop 

can be.

This stage is also the one where you can 

consider using photos in your work. Why now, 

and not later, is simple: later, it will be quite 

hard to work them properly into your painting, 

or so I found out the first time I did it. (This is 

the second time, in case you wonder!) Any 

earlier than this, and there may not be enough 

definition to a painting yet to see if or how 

something may work out.

Adding a Sky Photo
I’m not a matte painter and simply haven’t got 

the expertise to properly work a photo into a 

painting. Also, it doesn’t work with my style. 

These are things to consider when considering 

working with photos, or not. So I will simply 

use a photo of storm clouds I took recently 

(Fig.11) to add some more interest to the sky, 

and maybe work out some cloud formations and 

depth that way.

Bear in mind that this is something that can 

also be done by just adding various gradients 

or layers with different colors painted on 

them to the picture. However, I was asked to 

demonstrate adding a photo, so here we go:

We open the photo we want to use. I already 

know I want it turned so it’s upside down, so I do 

that right now (Image > Rotate Canvas > 180°). 

If you don’t know yet, that’s fine, because you 

can do that once it’s on the painting. 

Using the Move Tool, move it over 

to the painting. In this case, the 

best thing to do is to put it over the 

Background (Fig.12). This whole thing 

would be really easy if I had painted the cliffs 

on a separate layer, as I could have simply 

placed the photo between the background and 

the cliffs, and thus concealing the edges of the 

photo without much work. However, I only have 

a background that has everything on it.

To see what I am doing in the next step, I adjust 

the Mode of the photo layer in the Layers 

Palette – usually Overlay or Soft Light works 
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a treat – until I can see through it onto the 

background of the painting. If necessary we can 

also lower the Opacity a bit. 

We can now resize the photo to fit onto the part 

of the painting we want it on, and we do this by 

going to Edit > Free Transform. Being able 

to see through the photo helps me here 

to see where the cliff edges are, and I 

need to place and resize the photo so 

the trees will not be visible later (Fig.12a). 

Once I am happy with the placement, I apply 

the transformation. And now the fun starts!

Keeping the opacity semi-transparent, we pick 

the Eraser Tool           , choose a round and 70% 

hard Paintbrush, set its Opacity and Flow to Pen 

Pressure, but leave the Size Jitter switched off. 

We now can erase all the parts of the photo that 

go over the cliff edges, and also what sticks out 

over the horizon line. 

Having the bottom edge of the photo exactly 

touch the horizon line gives the impression that 

it’s pasted on, which is not desirable. You want 

the photo to blend in with the surroundings. 

Zoom in to erase near the edges of things, if you 

need or want to do that. I choose to keep parts 

of the photo overlapping with the cliffs, as it lets 

the colors from the photo spill over to the rocks 

(Fig.12b). It doesn’t matter if it’s not all that 

neat, as everything can be blended in later with 

the help of the Smudge Tool, as well as being 

overpainted.

Play around with the settings here, as well as 

with the colors and lightness/darkness using 

Variations or Levels – it’s amazing how these 

can affect the outcome! In this case, I decide 

to duplicate the later and desaturate it. The 

desaturated layer I set to Normal Mode with 

40% Opacity, while the original layer stays on 

Soft Light, but with only 87% Opacity. I then 

move the desaturated layer beneath the Soft 

Light layer (Fig.12c). Now we can see we still 

have some erasing to do, but mainly for the 

desaturated layer, as I still want the Soft Light 

layer to overlap.

As the original sky is shining through 

considerably, I smooth it out with a color I 

pick from the original sky, so the photo cloud 

formations are more visible. You can make 

those pop out even more by adding some 
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lighter colors where the clouds of the photos 

are – on the background layer, not on the photo 

(Fig.12d).

Note: As photos often have some kind of grain 

to them, especially when resized, they need to 

be edited to blend into a painting better. What 

I’ve found is that the Median Filter is very useful 

for this. You can find it under Filters > Noise 

> Median. Use a low setting to retain shapes, 

but get rid of the grain. It will give the photo a 

somewhat painted and slightly smudgy look. 

Depending on what you want or need, it can be 

left as is, or overpainted to give it some more 

painted definition.

Happy with the result, at least for now, we 

can choose to leave the layers as they are, 

or – if you find it slows down Photoshop 

because the image is getting too big 

because of all the layers – we can merge 

them with the background. For the moment, 

I decide not to merge them, but probably will 

once I want to work more on the background 

and overpaint bits and pieces here and there 

in the sky. For now though, we can turn our 

attention back to the girl.

Back to the 
Character
The dress still needs some work, and as the 

colors of the overall picture have changed, we 

should work some of those colors into the girl’s 

dress as well – namely the seemingly green-

turquoise tint we have floating around all over 

the place (Fig.13).

Pick it from the canvas, and add it in some 

selected spots. It looks pretty neat to see it 

popping up here and there, and it also ties 

everything together (Fig.13a).

With our color palette adjusted, let’s smooth 

out the fabric tendrils and folds of the dress, 

though not too much, as we want to keep 

some kind of texture in there. Very smooth 

fabric often looks plastic, and simply wouldn’t 

work here. Even when painting shiny silk – this 

one I imagine to be soft cotton or maybe raw 

chiffon – a certain amount of texture has to be 

retained to make it believable, and to avoid it 

looking plastic. We do the same with some of 

the cliffs in the background, to get rid of the very 

obvious brush marks that are telltale signs of “I 

used a speckled brush in Photoshop!” Hints of 

brushstrokes are cool; obvious unrendered ones 

are not, when a painting is overall smoothly 

rendered (Fig.13b).

So what’s next? I’d say we just keep painting 

for now. We’ve covered all the things we need 
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to know about building up an image, and to go 

on to the next step, our picture needs to be as 

refined as you want it to be. Therefore, I’ll finish 

this installment off with a few screenshots of the 

progress the image is making (Fig.14a – d).

In Closure
This certainly was a lot to take in all in one go, 

but I hope you’ve enjoyed seeing a painting take 

shape – in pictures and videos – and learnt a 

bit about what can be done (and undone) when 

something doesn’t quite work out from the start.

The next chapter will bring us closer to finalizing 

a painting, and with it, we’ll be looking at some 

nifty tools that come in very useful for all sorts of 

things, such as the Quick Mask, Extraction and 

Liquify Tools and Filters. We’ll also be learning 

about using custom photo texture brushes in 

our work to give it that extra little kick!

And talking of brushes, you can download the 

small set I have made for this chapter with some 

of the brushes I used this time around (click on 

the Free Resources icon). I’m sure you can find 

a use for them, too!

Nykolai Aleksander
For more from this artist visit

http://www.admemento.com/

or contact

x@admemento.com

• Free Brushes
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into the composition and therefore it had to 

be the most detailed and neatly drawn. Then I 

made a sketch of figures in motion.

With the initial sketch and composition worked 

out, I continued by drawing the figures and their 

costume details more accurately. At this stage 

I tried to pay more attention to the anatomy, 

elements of the costumes, and accessories, as 

it’s always much easier to change the motion, 

perspective or any other elements in a sketch 

than to make alterations later on when working 

in color. A good and solid drawing adds another 

30% to the success of an image (Fig.03)!

and dynamic composition contributes towards 

30% of the success of an image! So I started 

by sketching the motion and direction of the 

characters, forming the composition into a 

circle. The picture was divided into two planes: 

the imp in the foreground, and the angel in the 

background (Fig.02). 

The composition is not exactly ordinary, 

because the viewers become witnesses of 

the fight by looking at the battle scene over 

the imp’s shoulder, even though they’re not 

supposed to side with the dark force. The hand 

of the imp in the foreground is a point of entry 

Making Of ‘Imp Vs 
Angel-Warrior’
Software Used: Photoshop

How many representations of the fight between 

good and evil do you think have already 

been created? To add to the vast range of 

interpretations of this eternal theme, I chose 

to depict the two opposing forces through an 

example of two very specific characters – an 

imp and an angel-warrior. I’d like to walk you 

through the creation process of this particular 

artwork with a detailed description of my 

workflow. So here we go!

Concept 
The concept of the image is the fight between 

those two all-time enemies: good and evil; dark 

and light; order and chaos. On one side is the 

imp, and on the other is angel-warrior. I didn’t 

want to show the distinct advantage or winning 

stroke of one of the characters (although the 

good character is of course expected to win 

the fight), so I chose to feature the characters 

in-flight, approaching each other with aggressive 

poses. They are depicted in that crucial 

moment, just a second before the battle begins.

 

Sketching
My choice of canvas for this image was А3 

at 300 dpi – a good format for printing which 

also gives you the opportunity to pay more 

attention to the details. I cropped the landscape 

canvas slightly to make more of a square 

shape, and created a transparent layer over the 

white background on which to use my favorite 

standard brush (which I use in my work most of 

the time) (Fig.01).

I normally start a new piece by establishing the 

composition. I’m convinced that an interesting 

“A good and solid 
drawing adds 

another 30% to the 
success of an image!”
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and the angel-warrior received some metallic 

armor. At the same time I decided to alter the 

imp’s hand nearest the viewer, as a hand with 

claws looks much more dynamic and frightening 

than a clenched fist. The angel-warrior’s figure 

grows darker against the bright glowing wings 

behind him. The angel-warrior dominates and 

Color!
Under the layer with the drawing I created a 

new layer for working with color. At this stage I 

used texture brushes a lot (Fig.04); they helped 

make the background look more picturesque. 

The major idea for color solution in this image 

was to emphasize the conflict of opposites – 

something solemn, reddish-brown at the bottom, 

and something light and somewhat cool on top. I 

wanted to make the picture quite dark in order to 

be able to depict the glowing, magical wings of 

the angel-warrior. This is a simple technique to 

make objects glow: keep the surroundings dark. 

I then added highlights to the imp’s contour to 

show the light emitting from the angel’s wings 

(Fig.05).

Details
At this stage I decided on the colors of the imp 

and angel-warrior themselves, and sorted out 

the tone of the entire image. The imp was given 

his red, devilish skin color and bronze armor, 

makes the focal point of the entire composition; 

the imp’s figure also leads the viewer’s eye to 

the angel. 

As well as the warm yellow light which the 

angel’s magic wings are shedding, I also 

added some cool light-blue highlights from the 

sky to the back of the imp and on his helmet. 

I did this to add a cool accent to contrast 

the general warm feeling of the piece. With 

dynamic, diagonal strokes I added some blue 

sky highlights behind the angel, emphasizing 

the initial lines of the composition and the idea 

of confrontation. By skillfully arranging the tones 

and making harmonious color choices, you will 

go another 20% to making a successful image 

(Fig.06).

refining
In the previous stages I was working with color 

under the drawing layer, but here I added a 

new layer on top and gradually started refining 

“skillfully arranging the tones and making 
harmonious color choices, you will go 

another 20% to making a successful image.”
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the image, getting rid of the pencil lines from 

the sketch. This stage was quite simple, 

and contrary to the traditional principles of 

composition with regards to planning, detailing 

and development levels, I decided to go ahead 

and detail the angel-warrior in the distant view. 

I did this because the angel is just as significant 

as the imp in the story of the image. 

The chainmail on the angel’s armor wasn’t 

painted, but was a photo, altered to get the 

required form with the help of Free Transform. I 

then painted some individual chain links on top 

of it, to make it look handpainted. I worked the 

angel’s magical wings in a similar way: I found 

some pictures of smoke in my library, altered 

their form, and applied them over the image as a 

new layer. I set the blending mode for the layer 

to Overlay, and in return I received those fiery 

flashes (Fig.07).

The Final 20%
The final 20% lies in the skill to complete the 

art; not just to leave it as it is, but to complete it 

logically, to lay emphasis on the nuances that 

the viewer should see and to neutralize those 

which are less important, as well as adding 

some effects – highlights, overtones, “contre-

jour”, etc. 

I started with the imp in the foreground. I used a 

stone texture which I placed on a layer over the 

horns, the bone growths on the back and arms, 

and on the helmet and blades. I set the blending 

mode for the texture layer to Overlay, this way 

I achieved a more complex and interesting 

surface as the texture gave me the sense of 

material. I drew some cracks, scratches and 

highlights onto the helmet, and then took a 
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texture brush and applied several brushstrokes 

to the imp’s skin, adding a liveliness and 

roughness to it (Fig.08). I also added some 

highlights and a glow to the contour of the imp’s 

figure; the arm which is far from the viewer was 

highlighted with the cool overtone, which looks 

rather dramatic – a bright warm yellow spot in 

the foreground to highlight it and a light-blue 

overtone in the background. 

The angel-warrior’s sword has a glowing trail to 

give the necessary dynamics to the stroke. To 

the background I added sparks, highlights and 

some rays of light which are struggling through 

those dense clouds. And after adding these final 

effects to the composition, I had finished the 

image. Here it is in its final version (Fig.09).

Oleg Matsokin
For more from this artist visit

http://www.matsokin.com 

or contact

oleg@matsokin.com  
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